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Safety and Regulatory 
Compliance

Important Safety Information
Please read these instructions before attempting to operate the 
ChemiDoc™ MP imaging system.

This instrument is suitable for research use only. It must be used, therefore, 
only by specialized personnel who know the health risks associated with the 
reagents that are normally used with this instrument. 

Use of the ChemiDoc MP system involves UV illumination. Proper precautions 
must be taken to avoid eye and skin exposure to the UV radiation. This 
instrument is meant for use only by trained personnel who know the health 
risks associated with UV radiation normally used with this instrument. The 
acrylic shield provides some UV protection. However, it does not guarantee 
complete protection, and it is designed to shield only the person working in 
front of the system.

WARNING! Use of the acrylic screen does not guarantee the user 
protection from UV radiation. The use of protective eyeglasses, 
mask, and/or gloves is strongly recommended.

Warranty
The ChemiDoc MP imaging system is warranted against defects in materials 
and workmanship for one year. If any defect occurs in the instrument during 
this warranty period, Bio-Rad Laboratories, Inc. will repair or replace the 
defective parts at its discretion without charge. The following defects, 
however, are specifically excluded:

• Defects caused by improper operation
• Repair or modification done by anyone other than Bio-Rad 

Laboratories, Inc. or the company’s authorized agent
• Use of spare parts supplied by anyone other than Bio-Rad 

Laboratories, Inc.
• Damage caused by accident or misuse
• Damage caused by disaster
• Corrosion caused by improper solvents or samples
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General Precautions
• Please read the instruction manual carefully.
• The instrument must be used only for the intended purpose of gel 

documentation in research laboratories.
• The instrument must be connected to a grounded power source 

line and protected by a circuit breaker.
• Do not pour liquids directly on or inside the instrument.
• Switch off all the lights immediately after use.
• Clean the transilluminator platen after use.

Regulatory Notices
The ChemiDoc MP imaging system is designed and certified to meet 
EN61010, the internationally accepted electrical safety standards, EMC 
regulations, and TUV requirements. Certified products are safe to use when 
operated in accordance with this system instruction manual. This instrument 
should not be modified or altered in any way. Modification or alteration of this 
instrument will:

• Void the manufacturer’s warranty
• Void the regulatory certifications
• Create a potential safety hazard

WARNING! Bio-Rad Laboratories, Inc. is not responsible for any 
injury or damage caused by use of this instrument for purposes 
other than those for which it is intended or by modifications of the 
instrument not performed by Bio-Rad Laboratories, Inc., or an 
authorized agent.

Power Safety Information

VOLTAGE SETTING INFORMATION

The universal hood of the ChemiDoc MP imaging system has a power supply 
that automatically chooses the correct voltage for your country or region.
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FUSES

The universal hood of the ChemiDoc MP imaging system has two user-
serviceable fuses, F1 and F2, which are located on the bottom rear panel and 
are a part of the power entry module. Refer to the Maintenance chapter for 
fuse replacement instructions.
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 1 Introduction
The ChemiDoc™ MP imaging system offers exceptional application flexibility, 
high performance, and ease of use. The system contains a charge-coupled 
device (CCD) camera to capture images in real time and enable you to 
accurately position your sample and generate optimized image data.

The ChemiDoc MP system uses a new generation lighttight enclosure (the 
universal hood III), which contains built-in UV and white light illumination as 
well as available red, green, and blue Epi LED light sources. The system 
features dynamic flat fielding technology for superior image uniformity and 
accurate quantification.

Bio-Rad Image Lab™ software controls image capture and optimization for 
your selected applications, analyzes results, and produces reports based on 
your specified output, all in a single workflow.

ChemiDoc MP Imaging System
The ChemiDoc MP system is a high-resolution gel documentation system that 
allows fast, easy quantification of gels and blots. Position your sample inside 
the imager and follow the onscreen steps to run a protocol with only one click. 
You can customize your applications within an existing protocol or create a 
new protocol using the many options presented in Image Lab software. 
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The ChemiDoc MP imaging system also offers sensitive chemiluminescent 
detection. The system includes a supersensitive 16-bit CCD camera that is 
deeply cooled for faint-sample detection and for accurate quantification of 
image data.

Features include:
• Smart, application-based protocol setup using Image Lab 

software, which assists by presenting appropriate filter and 
illumination sources for imaging applications that require excellent 
sensitivity 

• Exceptional sensitivity and a dynamic range greater than four 
orders of magnitude

• Flexibility to image chemiluminescent, fluorescent, and colorimetric 
samples with dynamic flat fielding specific to each application

System Components

CCD Camera and Lenses
The ChemiDoc MP camera is placed on top of a lighttight enclosure (the 
universal hood) for capturing images. The camera comes with a motorized 
zoom lens (MZL) that allows remote adjustment of the lens control functions 
(zoom, focus, and iris). 

A patent-pending software algorithm controls the MZL, giving the user 
automatic image focus once an initial calibration is performed during system 
installation. See the Technical Specifications table for complete specifications 
of each system.

A +1 diopter lens is factory installed to allow the entire sample stage to be 
visible. This lens should always remain on the MZL assembly.

Universal Hood III
The universal hood III is designed to capture fluorescent and 
chemiluminescent images without using a photographic darkroom. The 
enclosure has built-in white light epi-illumination and UV transillumination. For 
easy sample loading, the UV transilluminator is located in the drawer of the 
universal hood and can be accessed from the front of the enclosure. When 
not imaging, the lights in the darkroom enclosure turn off automatically.
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The universal hood III has touchpad buttons to perform various functions; 
however, Image Lab software controls all of these functions remotely, 
removing any requirement for manual control of the lens and lights. Running a 
protocol overrides touchpad input.

Image Lab Software
The system ships with a full version of Image Lab software. In addition to 
controlling the imager system, image capture, and optimization, Image Lab 
software can be used to annotate and document images, analyze molecular 
weights (or base pairs, when imaging nucleic acid gels), and determine 
accurate quantification and purity of samples. 

You can print all or a subset of your data in a report. Alternatively, you can 
export your data to other software, such as Microsoft Office programs, for 
further analysis or presentation options. See Chapters 5 to 9 for detailed 
instructions on the software.

Emission Filters
The universal hood III can hold up to six different emission filters for 
fluorescent applications. No filter is required to image chemiluminescent 
samples. 

A standard filter is used for colorimetric (white light) applications and is 
included in the installation kit. 
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Optional Accessories
Bio-Rad Laboratories, Inc. offers a selection of optional filters and illumination 
sources. See Chapter C, Accessories on page 135 for ordering information 
and a complete listing of accessory filters, UV light sources, optional parts, 
and replacement parts.

Printer 
For your convenience, Bio-Rad offers an optional USB printer for use with the 
ChemiDoc MP system: the Mitsubishi thermal printer (catalog #170-8089).

Conversion Screens 

WHITE LIGHT CONVERSION SCREEN

The white light conversion screen is a phosphor screen that produces white 
light transillumination when placed on top of the UV transilluminator. 

XCITABLUE CONVERSION SCREEN

The optional XcitaBlue™ screen kit (catalog # 170-8182) converts UV to blue 
light, which enables you to visualize DNA samples while protecting them from 
UV damage. 

Optional Light Sources

RED LED MODULE

The optional red LED module kit contains the emission filter and excitation 
source for fluorescent applications. Instructions are also included.

GREEN LED MODULE

The optional green LED module kit contains the emission filter and excitation 
source for fluorescent applications. Instructions are also included.

BLUE LED MODULE

The optional blue LED module kit contains the emission filter and excitation 
source for fluorescent applications. Instructions are also included.
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System Requirements
Image Lab software runs under Windows XP Professional, Windows 7, and 
Mac OS X. Images scanned at high resolution can be quite large. The amount 
of memory required for using the program is determined mainly by the size of 
the images you scan and analyze. 

For this reason, we recommend that you archive images on a network file 
server or on removable storage media. Bio-Rad can also provide an 
appropriate computer to use with this system. Contact your local Bio-Rad 
representative for more details.

Computer Specifications

ChemiDoc MP Applications
The ChemiDoc MP system is capable of running protocols to image all the 
detection reagents from a variety of samples, either single-plex or multiplex 
applications, plus the others added to this list on the next page. Those listed 
are examples of the detection reagents that may be used to image your 
samples and not a complete list. Contact Bio-Rad technical support to 
determine whether your application can be imaged on this instrument. 

See Chapter 4, Acquiring Images, for detailed instructions on designing 
protocols.

Specifications Minimum Recommended

Operating system Windows XP SP3 
Windows 7, 32- and 64-bit
Mac OS X 10.6

Windows XP SP3 Professional
Windows 7 Professional, 64-bit
Mac OS X 10.6

Processor Pentium 4 or equivalent (Windows) 
at 2.0 GHz

Intel Core 2 Duo 2.0 GHz or higher

Hard disk space 20 GB >100 GB

Memory (RAM) 1,024 MB >1,024 MB 

Ports for connecting 
instrument

1 free USB 2.0 port 1 free USB 2.0 port

Other software 
(optional)

Microsoft Excel 2000 or later (Windows) Microsoft Excel 2000 or later (Windows)

Office 2008 or iWork software (Mac) Office 2008 or iWork software (Mac)
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NUCLEIC ACID GELS
• Ethidium bromide

• SYBR® Green

• SYBR® Safe

• SYBR® Gold
• PicoGreen
• GelGreen
• GelRed
• Fluorescein
• OliGreen
• GelStar

PROTEIN GELS
• Stain-Free Gel
• Oriole™ fluorescent gel stain
• Flamingo™ fluorescent gel stain
• SYPRO Ruby
• Krypton
• Coomassie Fluor Orange
• Pro-Q Diamond
• Pro-Q Emerald 300
• Pro-Q Emerald 488

BLOTS
• Chemi
• Chemi Hi Sensitivity
• Chemi Hi Resolution
• Stain-Free Blot
• Colorimetric
• Cy2
• Cy3
• Cy5
• Cy5.5
• Alexa 488
• Alexa 546
• Alexa 647
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• Alexa 680
• Dylight 488
• Dylight 549
• Dylight 649
• Dylight 680
• IRDye 680
• Rhodamine
• Fluorescein
• Qdots 525
• Qdots 605
• Qdots 625
• Qdots 705
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ChemiDoc MP Technical Specifications 
Applications

Chemiluminescence Yes

Fluorescence* Yes

Colorimetry/densitometry Yes

Gel documentation Yes

Hardware Specifications

Maximum sample size (L x W in cm) 28 x 36

Maximum image area (L x W in cm) 26 x 35

Maximum image area for standard 
UV-excited gels (L x W in cm)

25 x 26

Excitation source Trans-UV and Epi-white are standard (302 nm included, with 254 and 365 nm 
available as options). Optional trans-white conversion screen. Optional XcitaBlue™ 
UV/blue conversion screen. Blue, green, and red Epis.

Detector Supercooled CCD

Pixel size (H x V in microns) 6.45 x 6.45

Cooling system Peltier cooled

Camera cooling temperature –30°C controlled

Filter selector 6-position filter wheel, 1 without filter for chemiluminescence

Emission filters 1 included (standard), 3 optional (530, 605, 695)

Dynamic range >4.0 orders of magnitude

Pixel density (gray levels) 65,535

Dynamic flat fielding Application-specific, for all applications

Instrument size (cm) 36 (L) x 60 (W) x 96 (H)

Instrument weight (kg) 32

Operating Ranges

Operating voltage 110/115/230 V AC nominal

Operating temperature 10–28°C (21°C recommended)

Operating humidity <70% noncondensing

Automation Capabilities

Workflow automated selection Application driven, user selected or recalled by a protocol

Workflow automated execution Controlled by a protocol via application-specific setup for image area, illumination 
source, filter, analysis, focus, and reporting

Workflow reproducibility 100% repeatability via recallable protocols; from image capture to quantitative 
analysis and reports

Autofocus (patent pending) Precalibrated focus for any zoom setting
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ChemiDoc MP Imager Workflow
Following are the basic steps to acquiring, analyzing, and archiving an image 
using the ChemiDoc MP system and Image Lab software:

1. Select an existing protocol or customize a new one.

2. Position the sample to be imaged.

3. Run your selected protocol.

4. View the displayed results.

5. Optimize the analysis.

6. Generate a report.

7. Save or export the results.

When running chemiluminescent blots, you can use a signal accumulation 
mode, which takes a series of exposures within a period of time. This enables 
you to choose an image with optimal signal. Refer to Chapter 4, Acquiring 
Images, for instructions.

For More Information
Refer to the ChemiDoc MP Installation Guide found in your ChemiDoc MP 
installation kit for instructions on installing Image Lab software and 
assembling and calibrating the ChemiDoc MP system.

To recalibrate your system because you have acquired new accessories, refer 

to Chapter 2, System Calibration.

Image flat fielding (patent pending) Dynamic; precalibrated and optimized per application

Autoexposure 2 user-defined modes (intense or faint bands)

*Using the optional XcitaBlue kit (catalog # 170-8182) is highly recommended if performing preparative DNA applications 
with blue excitable stains. The UV to blue conversion screen allows you to visualize DNA samples while protecting against 
UV damage.
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2 System Calibration
When your system is installed, system calibration is performed with a 
calibration wizard. See the Installation Guide in your installation kit for detailed 
instructions.

The instrument calibration wizard performs several procedures required to 
automate the system and prevent focus problems. Each of these calibrations 
affects your system as follows:

• Focus Calibration — this calibration allows automated focus 
settings at any zoom point, using a (patent pending) software 
algorithm. Therefore, your focus remains correct whether you view 
an entire sample or an area of interest.

• Focus Calibration with Height Offset — this calibration takes the 
tallest of the available conversion screens into account, and 
extrapolates values for the others, so that focus remains optimal, 
whichever screen is used.

• Dark Reference Image (ChemiDoc™ MP only) — this calibration 
determines and corrects any background signal present in your imager.

• UV Flat Field Calibration — this calibration generates the flat field 
correction profiles needed for the UV light source. Because of this 
calibration, your images have backgrounds of even intensity.

• Lens Flat Field Calibration — this calibration corrects for the 
intensity roll-off inherent in any lens.

• White Conversion Screen Calibration — this calibration 
generates a flat field correction profile needed for the white light 
conversion screen.
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The Instrument Setup dialog box available from the Edit menu displays these 
calibration results for reference. The calibration wizard needs to be run only 
once, when your system is installed. The calibrations remain valid over the life 
of the instrument.

The calibration need not be changed unless you add equipment, such as a 
new light source.

When you add light sources or filters to a ChemiDoc MP system, recalibrate 
your system using the dialog box found at Edit > Instrument Setup.

1. If you have a new illumination source, select the appropriate box in the 
Illumination Options field.

2. If you are adding new filters, use the dropdown list to match what is 
installed in your instrument.

3. The software prompts you to reset the calibrations needed for the new 
illumination sources. 
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4. Click OK to exit the dialog box. Your settings persist until you make 
further changes.
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3 Image Lab™ Software 
Overview
Image Lab image acquisition and analysis software works with the 
ChemiDoc™ MP imaging system to create a reproducible, automated, and 
time-saving workflow for imaging and analyzing gels. 

In Image Lab software, a protocol is any combination of imaging, analysis, 
and report settings that has been saved to run as a single workflow. 
Researchers can run one protocol repeatedly or easily design a wide range of 
protocols. 

With Image Lab software you can view analyzed data, edit the analysis, and 
produce customized reports that show precisely the settings applied in order 
to ensure repeatable results. 

Two types of files are generated by Image Lab software:
• Image files, which contain the imaged gel, annotations, and 

analysis performed on the gel.
• Image files are saved with an .scn extension. An imaged gel, run 

according to a protocol file, generates an image file. Multichannel 
image files are saved with an .mscn extension.

 Interface Overview
The following illustration shows the Image Lab software main window. The 
paragraphs below describe the main software elements.
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MAIN WINDOW

Image Lab software displays a single main window. All image and protocol 
dialog boxes that present choices open in the workspace, which is the gray 
area of the main window. 

If many screens are open in the workspace, you can make one visible by 
clicking the title bar at the top of the selected screen. A list of open protocols 
and image files also appears in the Window menu; you can select one to bring 
it to the top.

You can view the complete analysis for an image or protocol at one time or 
compare image results by arranging the screens in the workspace.

Toolbar
Many Image Lab software tools can be selected by clicking toolbar icons. The 
Screenshot tool enables you to send a screen capture of your image to the 
clipboard or to save it as a file. You can view demonstrations of various 
functions by clicking Tutorials. The unlimited Undo and Redo buttons enable 
you to correct missteps easily. 
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Additional tools for viewing protocols and results data presented in various 
forms are labeled below. These tools are described in Chapter 5, Viewing 
Images.

Results Data
Results data associated with gel images can be viewed as an analysis table, a 
lane profile, a standard curve, or in a report. These views always display the 
analysis for the selected image. 

Buttons to toggle these views on and off are located in the main toolbar, as 
shown. All of them can be viewed at once. 

See Displaying Data on page 67 for details.

Display Toolbox
The display toolbox near the top of every image enables you to display 
images in the most useful ways. See Chapter 5,Viewing Images for a 
description of each option.

View results dataFile management
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Start Page
The Start Page guides you through creating, opening, and viewing protocols 
and images.
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Analysis Tool Box

The Auto Analysis  button quickly analyzes images. The 
remaining tools customize the analyzed data.

Note: An image file must be selected (on a Windows computer, 
the title bar is dark blue) to make analysis tools available. 

Image Tools enable you to flip, rotate, and crop images and to transform the 
image files. 
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Lane and Band Tools control the detection function, enabling you to resize, 
adjust, and bend lanes and to detect, adjust, add, or delete bands.

Normalization Tools enable you to normalize volume data in multichannel 
images, allowing you to correct for sampling loading errors in your gels.

MW (molecular weight) (or base pairs, if using nucleic acid gels) analysis 
calculation enables you to choose standard samples, assign standard lanes, 
and choose a regression method.

Quantity Tools enable you to automatically quantify bands, using either 
relative or absolute values.

Annotation Tools are useful for drawing attention to any area of a gel.

Volume Tools enable you to manually quantify an object inside a boundary 
that you define.

These tools are described on page 77.

Status Bar
The status bar in the lower right-hand corner of the main window shows the 
imager in use and the X and Y values for the cursor position on an image file.

The Int (intensity) values show a numerical value for the image intensity at the 
mouse position. The maximum data range using a ChemiDoc MP is 0 to 
65,535, but the range varies depending on the values contained within each 
image.

Note: For multichannel images, hovering over a multichannel 
pane displays color coded intensities for all channels. 
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Menu Commands
The following section describes all menu commands in the File, Edit, View, 
Window, and Help menus. Many commands are also available on the toolbar 
or the Start Page.

FILE MENU COMMANDS

New Protocol enables you to create a new protocol that contains the 
necessary steps and choices. See Acquiring Images on page 25 for detailed 
instructions. Protocols can also be altered and stored for reuse. 

Open browses the file system to retrieve a previously saved protocol file or 
image file.

Recent Images gives you the choice of opening a recent image file.

Recent Protocols gives you the choice of opening a recent protocol.

Save enables you to save a protocol or image file once the protocol or image 
is named.

Save As enables you to name and store a protocol or image. Protocols are 
stored with a .ptl file extension. Image files are stored with an .scn extension.

Multiplex protocols are stored with an .mptl file extension. Multiplex image 
files are stored with an .mscn extension.

Create Multichannel Image enables you to create a multichannel image from 
single-channel images and from single channels in other multichannel images.

Split Multichannel Image enables you to split the multichannel image into 
individual image files. Each file has the same name as the multichannel image; 
the application name is appended in parentheses.

Close closes the active screen.

Close All closes all the screens.

Export enables you to export gel images or analysis tables with the following 
options:

• Export for Publication — exports a displayed image to a file. You 
can select from .bmp, .png, .jpg, and TIFF formats. The gel 
displays with any lanes, bands, and annotations that appear on the 
screen. See Exporting Gel Images for Publication on page 120 for 
more information.

• Export for Analysis — creates a TIFF formatted file that retains all 
gel image data. Analysis data are not included. Use this option to 

analyze the image in other software such as Quantity One®,



ChemiDoc MP | Image Lab™ Software Overview

22

FPQuest™, or InfoQuest™FP. See Exporting Gel Images for 
Analysis on page 122 for more information.

• Export for PulseNet — reduces the image to an 8-bit TIFF image 
file. Resolution is limited and file size is restricted to 300 dpi.

• Lane and Band Table to Excel — if Excel (or Numbers on a Mac) 
is installed on your computer, it will launch with your lane and band 
table displayed as a spreadsheet.

• Lane and Band Table to File — exports as a CSV (comma-
separated values) file so your lane and band table can be opened 
in a database application.

• Volume Table to Excel — if Excel (or Numbers on a Mac) is 
installed on your computer, it will launch with your volume table 
displayed as a spreadsheet.

• Volume Table to File — exports as a CSV file so your volume table 
can be opened in a database application. See Exporting Results on 
page 119 for detailed information about exporting files.

Image Info displays information about individual gel and blot images such as 
acquisition date, data range, and image capture details including the 
exposure time and illumination source used, in three tabs (Image Details, 
Analysis Settings, and Notes). See Image Info on page 62 for more 
information. See Chapter 9 for more information about exporting files.

• Page Setup contains print controls such as orientation (landscape 
or portrait), margins, printer used, and paper size.

• Print displays a print preview of the gel and the header information, 
which includes the filename of the image, the user’s name, and 
date and time it was printed. The usual Windows Print screen is 
available as well; it enables you to select a printer and the number 
of copies to print.

• Exit closes Image Lab software (after prompting you to save 
changes to your protocols or images). 

EDIT MENU COMMANDS

Undo undoes the last action.

Redo restores the last action after an Undo.

Screenshot enables you to take a screen capture of the Lane Profile Window, 
the Standard Curve Window, or the default choice, Current Image View. This 
capture can include the name of the image, and it can be placed on the 
clipboard or saved in a file.
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Default Imager enables users who own two or more imagers to switch 
between them.

Instrument Setup enables you to review the instrument serial number and 
how the imaging system is calibrated. If accessories are added, change the 
system calibration in the Instrument Setup dialog box.

Report Settings enables you to configure reports. This dialog box contains 
three tabs. All of the checkboxes are selected by default; clear the boxes to 
exclude information from reports. Your selections apply to all reports until you 
change them again.

• The General tab has options for excluding or reporting information 
about your gel image.

• The Lane and Band Table tab enables the researcher to choose 
whether to include all, or just some lanes, with appropriate 
identifiers. Lane profiles can also be included.

• The Volume Table tab enables the researcher to choose 
appropriate identifiers for the Volume Table and provides the option 
of excluding the table from reports.

Preferences contains two tabs.
• The Protocol tab shows presets for naming image files. You can 

choose to include a designated Prefix, User Name, Date, and/or 
Time in the name of your image files.

• The Colors tab enables you to choose colors for the graphic 
elements in your gels, such as Lane Frame, Lane, Band, Band 
Attribute, and MW Legend. This functionality ensures that these 
elements are visible, whatever colors your gels are.

VIEW

Image Overview opens a small window that shows the entire gel image with 
a red rectangle outlining the area visible in the larger main window. This is 
useful when you zoom in to a small section of an image.

Image Transform opens a window showing a histogram, which allows you to 
adjust the light and dark values of a gel image. This adjustment does not 
change your data; it changes only the way the data display on your monitor.

Operations History opens a window showing the sequence of actions 
performed by both the user and the software.
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WINDOW

The Window controls enable you to show and hide multiple open image files 
in your workspace. A list of all currently open images and protocols appears in 
this menu.

Tile aligns all open image files so all are visible at once.

Tile Horizontal places all open image files from top to bottom.

Tile Vertical places all open image files from left to right.

Cascade stacks all open image files and protocols with overlapping title bars, 
so each one can be easily chosen for view.

Imitate Zoom changes the zoom setting of all open images to the same zoom 
setting as the current image file.

Imitate Transform changes the brightness and contrast of all open images to 
the same transform settings as the current image file.

Next cycles through all open image files from oldest to newest.

Previous cycles through all open image files from newest to oldest.

HELP

Image Lab Help displays the help system. 

User Guide displays the instruction manual in .pdf form.

About displays Image Lab software version and release date.
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4 Acquiring Images
Image Lab software runs specific applications with repeatable workflows 
using custom protocols that have a wide variety of settings. These protocols 
can be retrieved, revised, and reused. 

In Image Lab, a protocol is any combination of settings for imaging, analyzing, 
and reporting that runs as a single workflow.

Image Lab supports two kinds of protocols: single-channel and multichannel. 
A single-channel protocol enables you to choose one application for 
acquisition of a single image from a sample, with the exception of signal 
accumulation mode for chemiluminescence. Multichannel protocols enable 
you to choose up to three different applications, resulting in sequential 
imaging of a sample. These images can be combined into an RGB (red, green, 
blue) color-composite image.

Note: The Image Lab software is designed to work with different 
imagers, some of which work only with single-channel images. 
The New Protocol menu choices change depending on whether 
the imager supports multichannel images or not. If you do not 
see the multichannel option, check to see that your imager 
selection is set to ChemiDoc™ MP.

To access the Protocol Setup window
• Click the New Protocol button in the toolbar, and then select Single 

channel or Multichannel in the menu that appears.
• In the Protocols box on the Start Page, click New Single Channel or 

New Multichannel.
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The appropriate Protocol Setup window appears for the type of protocol you 
selected.

The Protocol Setup Window

Single-Channel Protocols
This is the Protocol Setup window for a single-channel protocol. The left pane 
displays headings. Under the headings are numbered protocol steps. You can 
enable or disable a step by selecting or clearing its checkbox. When you 
select a step, the right pane of the window displays the detailed settings for 
that step.

You can review protocol settings by selecting Protocol Summary, which lists 
the settings for each step in the right pane of the Protocol Setup window.
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Multichannel Protocols
The Protocol Setup window for multichannels has some settings that differ 
from the single-channel Protocol Setup window, but you work with it the same 
way as the single-channel Protocol Setup window.

Select a step in the left pane and configure the settings for that step in the 
right pane.

Click Protocol Summary in the left pane to view all your protocol settings in 
the right pane.
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Creating a Protocol
There are three categories of settings when setting up a protocol: 

• Acquisition Settings – settings to acquire the image
• Analyze Image – lane and band analysis and molecular weight 

analysis settings
• Generate Output – settings to generate the output

The three processes are listed in the left pane of the Protocol Setup window. 
Numbered steps in each process appear under these headings. To select an 
option under a protocol step, select the accompanying checkbox. Options for 
that step appear in the right pane of the window. To disable any step, clear its 
checkbox.

There are some differences in the gel imaging settings of single-channel 
protocols and multichannel protocols. (These settings are selected in “Step 1. 
Gel Imaging,” in the Protocol Setup window.) The remaining steps in the 
protocol setup are virtually identical.

To start creating your protocol
• To create a single-channel protocol, start with “Step 1. Gel Imaging 

for Single-Channel Protocols” on page 30.
• To create a multichannel protocol, start with “Step 1. Gel Imaging 

for Multichannel Protocols” on page 34.
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Step 1. Gel Imaging for Single-Channel 
Protocols

1. Click Select and choose an application from the menu. The applications 
appear in submenus under each application type. When you choose an 
application, any required filter or illumination source displays in the 
Protocol Setup window.

Note: For a list of applications with all required detection 
reagents, light sources, and any conversion screens or filters 
noted, see Application Tables on page 53.
Note: If you select the Stain Free application you have the option 
of selecting the gel activation time. See Using the Criterion Stain 
Free™ System, for more information.
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Choose the Custom application to run an existing application with a 
new name or an application unlike existing applications. Selecting 
Custom on the Application menu displays the Manage Custom 
Applications dialog box. If you previously saved custom applications, 
they display here.

To create a new custom application, click New in the Manage Custom 
Applications dialog box.

The Create Custom Application dialog box appears.

2. Choose a unique application name. 

3. Select a light source, filter, and image color from the lists.

4. Select a binning setting. Choosing a higher binning setting combines 
pixels to increase the amount of signal without increasing noise. While a 
higher setting provides optimal sensitivity for low-light applications 
such as chemiluminescence, it also reduces image resolution.

5. Click OK to create your custom application.
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6. In Imaging Area, select from the list of Bio-Rad gels or enter image area 
dimensions. The red line represents the imaging area for the selected gel, 
and the gray rectangle represents the imager sample stage.

7. In Image Exposure, select from one of the following options: 
• Auto Exposure — this setting estimates an optimal exposure 

time and ensures the best use of the dynamic range. Intense 
Bands optimizes for all bands and Faint Bands makes faint 
bands more visible but may overexpose more prominent bands.

• Manual Exposure — use this setting to manually override 
automated imaging. Exposure time can range from 0.001 to 
7200 seconds with the ChemiDoc MP system. 

After imaging a gel with automatic exposure optimization, the display provides 
a reference point (see below) from which to set your manual exposure time.

Note: You can also view the exposure time of the image later, in 
the Image Info window (see Image Info on page 62).

Signal Accumulation Mode — if you are running a chemiluminescence 
application on the ChemiDoc MP system, you can also use signal 
accumulation mode (SAM).
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SAM allows you to get a cumulative sequence of exposures from a 
chemiluminescent sample to increase the likelihood that you will get the 
correct image. 

Rather than manually acquiring a series of independent images with 
different imaging times, SAM presents a series of cumulative images 
with progressively greater signal in each image. SAM is a partially 
automated method for image acquisition because it requires that you 
estimate the shortest and longest times expected to generate an image 
with the appropriate signal intensity. You then decide how many total 
images to acquire in this time frame. 
Note: For any given exposure time, you will get more background 
noise with a SAM acquisition than you would with a single image 
taken at the specified exposure time.

For example, if the minimum time that is expected to image the sample 
is 1 min and the maximum is 5 min, these values are entered (in sec) in 
the setup window. By entering 5 in the “Total number of images” field, 
three images will be acquired between the first and last images.

To use SAM, click Signal Accumulation Mode and select Setup to 
display the Signal Accumulation Setup dialog box.

In this example, the bar in the Signal Accumulation Setup dialog box 
shows that images will be acquired at 1 min intervals, beginning at 
1 min and ending at 5 min. The second 1 min image is added to the first 
1 min image, resulting in a 2 min total integration time image. The third 
1 min image is added to the previous image, and so on, until the last 
image is presented.
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Although SAM is useful for determining the optimum imaging time for a 
chemiluminescent sample, it results in data that are not as accurate as 
data from a single image. Signal that is near the intensity of background 
noise becomes increasingly masked as the number of cumulative 
images increases. To identify extremely faint signals in an image, 
reacquire it as a single image, using the time the SAM tool found to be 
appropriate.

8. In Display Options, choose one of the following:
• Highlight saturated pixels — select this checkbox to see any 

saturated pixels in red. This shows how much of the gel image is 
saturated. This option can be changed later by selecting View > 
Image Transform.

• Image color — select color choice to display the sample image. 
Viewing the image with a different color scheme can make it 
easier to see all of the elements. See Image Colors on page 60 
to view the color choices dialog box.

Note: Continue with the next step in setting up the single-
channel protocol by going to Step 2. Detect Lanes and Bands on 
page 39.

Step 1. Gel Imaging for Multichannel 
Protocols
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You must configure acquisition settings for at least two channels to create a 
valid multichannel protocol. Each channel can be assigned a color (red, green, 
or blue) so you can easily identify each channel. Configure each channel 
separately.

To configure the acquisition settings
1. In the right pane of the Protocol Setup window, click Configure in the 

Channel 1 box. The Configure Channel 1 dialog box appears.

2. Click Select and choose an application from the dropdown list that 
appears.

Note: Use the Custom application to run an existing application 
with a new name or an application unlike existing applications. 
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See Setting Up a Custom Application on page 52 for more 
information.

For a list of applications with all required detection reagents, light sources, 
and any conversion screens or filters noted, see Application Tables on 
page 53.

3. In Image Exposure, if you select the first radio button, Image Lab 
acquires an image estimating an optimal exposure time. This option 
ensures the best use of the dynamic range.
• If you choose Intense Bands from the list, exposure is optimized 

for all bands. 
• If you choose Faint Bands from the list, a longer exposure 

makes faint bands more visible, but more prominent bands may 
be overexposed.

• If you select the second radio button to manually override 
automated imaging, you can set the exposure time from 0.001 
to 7200 seconds with the ChemiDoc MP system. 

After imaging a gel with automatic exposure optimization, the exposure 
time displays in the protocol so you can manually adjust it if needed.

Note: You can also view the exposure time of the image later, in 
the Image Info window (see Image Info on page 62).

Signal Accumulation Mode — if you are running a chemiluminescence 
application on the ChemiDoc MP system, you can also use signal 
accumulation mode (SAM). 
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SAM is used to simplify capture of a good image from a 
chemiluminescent sample. This sample type often requires long 
integration times to obtain an image that represents the best range of 
signal.

Rather than manually acquiring a series of independent images with 
different imaging times, SAM presents a series of cumulative images 
with progressively greater signal in each image. SAM requires you to 
estimate the shortest and longest times expected to generate an image 
with the appropriate signal intensity. You then decide how many total 
images to acquire in this window of time.

For example, if the minimum time that is expected to image the sample 
is 1 min and the maximum is 5 min, these values are entered (in sec) in 
the setup window. By entering 5 in the “Total number of images” field, 
three images will be acquired between the first and last images.

To use SAM, click Signal Accumulation Mode and select Setup to 
display the Signal Accumulation Setup dialog box.

In this example, the bar in the Signal Accumulation Setup dialog box 
indicates that images will be acquired at 1 min intervals, starting at 
1 min and ending at 5 min. The second 1 min image is added to the first 
1 min image, and the image is the result of integrating these two 
images. The third 1 min image is added to the previous image, and so 
on, until the last image is presented.

Although SAM is useful for determining the optimum imaging time for a 
chemiluminescent sample, it results in data that are not as accurate as 
data from a single image. Signal that is near the intensity of background 
noise becomes increasingly masked as the number of cumulative 
images grows. To identify extremely faint signals in an image, reacquire 
it as a single image, using the time the SAM tool found to be 
appropriate.
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4. Set the following attributes in Display Options:

Highlight saturated pixels — select the “Highlight saturated pixels” 
checkbox to see any saturated pixels in red. This shows how much of 
the gel image is saturated. This option can be changed later by 
selecting View > Image Transform.

Channel Color — select a color to display the sample image. Assigning 
each channel a different color makes it easy to identify each channel. 
Once you set up the first channel, the second channel box becomes 
active. 

5. Repeat steps 1 through 5 to set up the second channel and the third 
channel, if applicable. The software determines which applications are 
available based on the previously selected applications. Each Configure 
box displays the settings for that channel. 

You can reconfigure channel settings by clicking Configure in the 
channel box and changing the settings.

6. In Imaging Area, select from a list of Bio-Rad gels or enter the image 
dimensions. The red line represents the imaging area for the selected gel, 
and the gray rectangle represents the imager sample stage.
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Step 2. Detect Lanes and Bands
The following is a screen shot of the Detect Lanes and Bands window for 
single-channel protocols.

To analyze the gel or blot, Image Lab must detect lanes and bands on the 
image. Lanes are detected automatically, and then the background is 
subtracted automatically. Refer to Using the All Lanes and Single Lane Tools 
on page 82 for details. Customize band detection with the following options.

To configure the lane and band detection settings
1. Select the Lane and Band Detection checkbox in the left pane of the 

Protocol Setup window. 

2. In the right pane, select one of the following lane and band detection 
options:
• Low Band Detection Sensitivity — this option sets detection at 

a low level (25) for images with more prominent bands. Faint 
bands are not detected with this setting.

• High Band Detection Sensitivity — this option sets detection 
at a higher level (75) for images that are more faint. Extraneous 
bands can be removed later, using the Band Tools in the 
Analysis Toolbox. See Lane and Bands Tool on page 80.
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• Custom — select a numeric value between 1 and 100 to choose 
the best detection sensitivity for your sample.

Note: You cannot specify different sensitivity levels for individual 
channels of a multichannel image. The same sensitivity level is 
applied to all channels. After the image is generated, you can 
change the sensitivity level for individual channels using the Lane 
and Bands Tools.

The following is a screen shot of the Detect Lanes and Bands window for 
multichannel protocols.

To configure normalization settings
1. (Multichannel protocols only) Click Normalization Channel and specify 

which channel to use as the normalization channel. 
The selected channel is used as the normalization factor against which 
all other lanes in the channels are compared to normalize the volume 
data. 
You can defer making a selection during the protocol setup and 
normalize your data after the image is generated. For more information 
on normalizing volume data, see Normalizing Volume Data on page 87.
Note: You must select an application for at least one channel in 
“Step 1. Gel Imaging” in order to see a list of choices.

2. Select the type of normalization you want to use:
• Total Lane Protein Normalization – One lane in the 

normalization channel is used to calculate the normalization 
factor.
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• Housekeeping Protein Bands Normalization – A single band 
of a housekeeping protein is used to calculate the normalization 
factor.

Step 3. Analyze Molecular Weight
The following is a screen shot of the Analyze Molecular Weight window for 
single-channel protocols.

Note: The Analyze Molecular Weight window for multichannel 
protocols is identical except that the background color of the left 
pane is pink instead of blue.

Determining molecular weight depends on selecting the proper protein 
standards. Many protein standards are available from Bio-Rad. Many different 
DNA standards are also available. See the Ordering Information on page 141 
for all Bio-Rad standards and their catalog numbers.

Click Change to open the Manage Standards dialog box, where you can add 
third-party standard samples and edit the list.
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To specify how molecular weight is analyzed
1. To analyze molecular weight automatically, select the Analyze Molecular 

Weight checkbox in the left pane of the Protocol Setup window. The 
software calculates the molecular weight for each band based on the 
specified standard.

2. To estimate the size of the molecules in the bands of your gel, enter the 
standards you are using and specify the lane(s) in which the standards 
are placed. For nucleic acid samples, use this step to determine the 
size of the bands in base pairs.
Choose which lane contains your standards by typing lane numbers or 
the words First and Last in the Standard Lanes field. The format is xx, 
xx, xx, ... where xx is the lane number. For example, if you run an 18-
well gel and want your standards in lanes 1, 10, and 18, enter First, 10, 
Last.
Note: Lane detection works best when standards are placed in 
the first and last lanes.

For more information, see Molecular Weight Analysis Tools on page 96.
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REGRESSION METHODS

A regression method is used to calculate the molecular weight of the unknown 
bands. The software uses the relative front and molecular weight values of the 
standard bands to calculate the standard curve. This standard curve is then 
used to calculate the values of the unknown bands. The shape of the standard 
curve is based on the selected regression method. Choose one of the four 
regression methods listed below. 

If you do not have enough data points for the selected method, the molecular 
weight of the unknown bands is not calculated.

To set the regression method for the protocol
1. Select the appropriate method for the gel type:

• Gradient gels — the linear (semilog) regression method works 
well for these gels because the mobility of the bands is linear to 
the log of their molecular weight. As an alternative, the point-to-

point (semilog) method can be used if the R2 value is not 
sufficient.

• Fixed percentage gels — these gels have a nonlinear 
relationship between the mobility and the molecular weight. For 
these gels, choose the logistic or cubic spline regression 
method.

You can check how well each regression method fits the data in the standard 
curve window (see Standard Curve on page 74 for more information). The 
linear (semilog) regression method provides a measurement that describes 

how well the standard curve fits the data R2 value. The closer the R2 value is 
to 1.0, the better the data fit the standard curve.

The molecular weight of each band is displayed in the analysis table in the 
Mol. Wt./Base Pair column. Refer to page 123 for more information about 
molecular weight.

For information about the calculations behind the regression methods, see 
Regression Calculation Methods. 

Regression Method Minimum number of standard bands

Linear (semilog) 2

Point-to-point (semilog) 2

Logistic 5

Cubic spline 5
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Step 4. Specify Output
Image Lab prints to the default printer unless you select otherwise.
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Creating a Multichannel Image from Single 
Images

You can create a multichannel image from existing single images or from 
single channels in other multichannel images. Only images with the same 
aspect ratio can be combined in a multichannel image. These images are not 
linked to one another; therefore, when you make a change to one image, it is 
not propagated to the other images.

To create a multichannel image from single images
1. Open the single images from which you want to create a multichannel 

image.

2. In the File menu, click Create Multichannel Image. The list of open 
images appears in the left pane of the Create Multichannel Image dialog 
box.

3. Drag each image into one of the channel boxes in the right pane. After 
you select the first file, the Available Open Images list displays only files 
with the same aspect ratio.

4. (Optional) Specify a color for each channel in the accompanying 
dropdown lists. The resulting multichannel image appears in the Image 
Preview section of the dialog box.

5. Click OK to save the multichannel image.

To replace a channel in a multichannel image
1. Open the multichannel image and the new image you want to use. 

2. In the File menu, select Create Multichannel Image. The open image 
files are listed in the Available Open Images list of the Create 
Multichannel Image dialog box.

3. Drag the images from the Available Open Images list (left pane) into the 
channels in the New Multichannel Image pane (right pane).

4. Drag the new image you want to use into one of the channel boxes.

5. Click OK to save the new multichannel image.
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Choosing a Protocol
To open a saved protocol

• Click Open on the Start Page or click File > Open on the menu bar. 

You can also choose recently used protocols or image files from the lists on 
the Start Page.
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Editing Protocols
You can change the protocol settings and rename the protocol using Image 
Lab tools.

Open any saved protocol. You are presented with the same set of menus and 
choices described in Creating a Protocol on page 29.

Edit and save your changes without renaming the protocol to update an 
existing protocol. From the File menu, choose Save As and type a different 
name to create a new protocol.
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Positioning the Gel

To position a gel
1. Click the yellow Position Gel button in the Protocol Setup window 

shown on page 47.

2. Place a gel on the imager stage and view the gel in Image Lab.

3. Use the slider below the image to zoom the image into place. You can 
also move the gel manually until it is centered properly on the stage.
Note: The Bio-Rad gel alignment template kit supports four sizes 
of standard agarose gels to be centered quickly and easily. See 
Appendix C, Accessories, for more information.
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Running a Protocol
To execute a protocol

• Click Run Protocol in the left pane.

The software runs through the steps in imaging mode, imaging each channel. 
A message at the bottom of the screen indicates the channel being imaged 
and a progress indicator tracks the process.

Note: If you run a chemiluminescence application using auto 
exposure, you may see the following error message: The sample 
is too faint to use the auto exposure setting. Change the Image 
Exposure setting to use manual exposure or Signal Accumulation 
Mode (SAM), then run the protocol again. This error occurs if 
Image Lab, using the initial autoexposure algorithm, determines 
that it would take too long (approximately 30 minutes or more) to 
acquire an image. You can always use the manual Image 
Exposure setting and specify a longer exposure time.

After the images are taken, Image Lab continues with the detection, analysis, 
and reporting steps if these steps were selected in the Protocol Setup pane. 
When Image Lab has completed running the protocol, it displays the images 
that were acquired. You can then edit and save these images or do further 
analysis on them.

To end the protocol
• Click Cancel Run.
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Running Signal Accumulation Mode (SAM) 
Protocols

You can interrupt the acquisition of images for a SAM-enabled protocol at any 
time by clicking the “Stop Acquire and Continue with Selected” button. The 
acquisition process stops and continues the protocol with the selected image. 
Any other images that were acquired are discarded.

At the end of the acquisition process, a thumbnail of each image appears at 
the bottom of the window. The last image acquired appears, by default, in the 
main window. You can view any of the SAM images in the main window by 
clicking on the thumbnail image.

Review the images, select the image you want to use in your analysis, and 
click the Select Image and Continue button. Image Lab continues to the next 
step in the protocol using the selected image.

Note: Once you click the Select Image and Continue button, only 
the selected image is retained. All other images are deleted. 
Therefore, save any other images you want to keep before 
continuing with the protocol. See Saving Signal Accumulation 
Mode (SAM) Images on page 51 for more information.



Running Signal Accumulation Mode (SAM) Protocols

51

Saving Signal Accumulation Mode (SAM) 
Images
You can save any individual image or you can save all images once by 
right-clicking on the image and selecting an option from the shortcut menu.

To save a single SAM image
1. Right-click the thumbnail and click Save on the menu.

2. In the Save File dialog, accept the default name for the file or enter 
another name, and click Save.

To save all SAM images
1. Right-click any of the images and click Save All on the menu.

2. In the Select Directory dialog, enter the name of the folder and click 
Select Folder.
The images are saved in the specified folder. The name of the file 
includes the user name, timestamp, and exposure time. For example: 
John Doe 2012-05-01 15 hr 44 min_Exposure_5.0sec.
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Setting Up a Custom Application
Use the Custom application to run an existing application with a new name or 
an application unlike existing applications. Selecting Custom on the 
Applications menu displays the Manage Custom Applications dialog box. If 
you have stored Custom Applications, they display here.

To create a custom application
1. Click New in the Manage Custom Applications dialog box.

The Create Custom Application dialog box appears.

2. Enter a unique application name. 

3. Select a light source, filter, and image color from the lists. 
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4. Select a binning setting. Choosing a higher binning setting combines 
pixels to increase the amount of signal without increasing noise. While a 
higher setting provides optimal sensitivity for low-light applications 
such as chemiluminescence, it also reduces image resolution. 

5. Click OK to create the custom application.

Application Tables
The following tables list the applications and primary filters for each light 
source.

Base System—UV, Standard Filter

Ethidium bromide Krypton

SYBR® Green Coomassie Fluor Orange

SYBR® Safe Pro-Q Diamond

SYBR® Gold Pro-Q Emerald 300

GelGreen Chemi

GelRed Chemi Hi Res

Fluorescein Chemi Hi Sens

OliGreen Stain-free blot

PicoGreen Colorimetric

GelStar Rhodamine

Stain-free Qdot 525

Oriole™ Qdot 605

Flamingo™ Qdot 625

SYPRO Ruby
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White Trans, 
Standard Filter

Blue Epi (catalog #170-8285)
530/30 Filter

Fast Blast™ stain Pro-Q Emerald 488

Coomassie Blue CY2

Silver stain Alexa 488

Copper stain DyLight 488

Zinc stain

Red Epi (catalog #170-8283) 695/55 Filter

CY5 DyLight 650

CY5.5 DyLight 680

Alexa 647 IRDye 680

Alexa 680 Qdots 705

Green Epi (catalog #170-8284) 605/50 Filter

CY3 DyLight 549

Alexa 546

Xcita Blue™ (catalog #170-8182) Standard Filtera

a. Use the Xcita Blue screen to visualize gels without causing UV 
damage to the DNA. This is useful when you want to excise portions 
of the DNA.

SYBR® Green (excision) Fluorescein (excision)

SYBR® Safe (excision) OliGreen (excision)

SYBR® Gold (excision) PicoGreen (excision)

GelGreen (excision) GelStar (excision)
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5 Viewing Images
Once a gel has been imaged, the image appears in the workspace. Many 
controls are available to optimize viewing and to analyze the image.

Results Overview
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The screenshot above shows a gel image with band and lane detection as 
well as annotations. The labels are overlays that you can display or hide. 

There are many ways to view the data associated with the results. You can 
view data as an analysis table, a lane profile, a standard curve, and a report. 

Displaying Gel Images 
Notice the display toolbar buttons above the gel image. Each of these tools is 
described in the following sections.

Display Gel Options 
The figure below is a screenshot of the Display Gel Options dialog box. The 
sections that follow describe the settings in the dialog box.

ANNOTATIONS

You can choose whether to show text and arrow annotations that have been 
drawn on the image.
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LANES AND BANDS

You can turn on or off any image overlays, such as lane frames, lanes, bands, 
lane labels, and molecular weight legends.

BAND ATTRIBUTES

You can show the following attributes for selected lanes or for all lanes.
• Band number
• Band label
• Molecular weight
• Relative front
• Volume
• Absolute Quantity
• Relative Quantity
• Band %
• Lane %

VOLUMES

If you have drawn volume boundaries on the gel, you can display the volume 
boundaries and their volume labels.

Zoom Tools 
The zoom tools resize the gel image. Click the magnifying glass with the plus 
sign to make the image larger; click the magnifying glass with the minus sign 
to make the image smaller.

You can also zoom in on an area using the right mouse button. Right-click and 
drag to select the area you want to magnify. You can also resize the image 
with the scroll wheel on your mouse.

Tip: You can return to the original view with one click by 
right-clicking anywhere on the image.

Fit in Window 
If you have zoomed in on an area of an image, clicking this button brings the 
entire image back into view.
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Image Transform 

 

Use the Image Transform dialog box to adjust image brightness and contrast, 
optimizing the image display so faint details can be seen. The minimum to 
maximum range varies depending on the light and dark values present in the 
image. These adjustments do not change the data; they change only the way 
the data are displayed. The human eye cannot see as great a range as the 
image contains.

The frequency distribution histogram shows the total data range in the image 
and the amount of data at each point in the range.

Auto Scale determines an optimal setting for the image automatically. The 
lightest part of the image is set to the minimum intensity, and the darkest is 
set to the maximum.

• The High progress indicator determines which intensity value is 
shown at the maximum gray scale (or other color) in the gel image.

• The Low progress indicator determines which intensity value is 
shown at the minimum gray scale (or other color) in the gel image.

• The Gamma progress indicator changes the gray scale curve. A 
value of 1 is linear. A value <1 redistributes a greater proportion of 
the gray scale to the first half of the intensity values. A value >1 
redistributes a greater proportion of the gray scale to the second 
half of the intensity values.

You can also type numerical values in the text boxes next to the progress 
indicators. Clicking anywhere on the progress indicator bars moves the 
progress indicator incrementally.
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Options:
• Invert image display — inverts dark bands on a light background 

to light bands on a dark background. Light bands on a dark 
background are inverted to dark bands on a light background.

• Highlight saturated pixels — when this checkbox is selected, 
areas of the image with saturated signal intensity (above a 
measurable range) are highlighted in red.

• Linear or logarithmic histogram — this adjustment changes the 
y-axis on the histogram to display the number of pixels at each 
intensity value using either a linear or a logarithmic scale.

Note: In multichannel images, you can individually highlight the 
saturated pixels on a channel in red. You cannot highlight the 
saturated pixels in a merged image.

FOR MULTICHANNEL IMAGES

In the Image Transform dialog box, you can make changes to only one image 
at a time. When you work with a multichannel image, you can select each 
channel, in turn, at the bottom of the Image Transform dialog box and make 
any changes to the image. 

In addition to the adjustments described in Image Transform on page 58, you 
can change the color of each channel. Changing the channel color in the 
Image Transform dialog automatically updates the title bar and the channel 
buttons in the multichannel image.

Changing the transform changes the transform of the selected channel and 
the change is reflected in the merged image.
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Image Colors 

You can choose a colormap for your image results file. Viewing the image with 
a different color scheme can make it easier to see all of the elements in the 
image, but it does not change your data.

Note: In multichannel images, colors can be changed only for the 
individual channels. You cannot change the colors of a merged 
image.

The first eight color choices imitate the colors of stained gels. The remaining 
choices supply enough color variation to highlight small differences in the 
image data. The available colors include:

• Gray
• Flamingo™
• EtBr (Ethidium bromide)
• Silver
• Coomassie
• False color
• Stain-free
• Spectrum

• SYBR® Green
• Gold-silver
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• SYPRO Ruby
• Pseudo

3-D Projection 

The 3-D View button transforms the gel image into a solid 3-dimensional 
model spinning in space with x, y, and z dimensions. Accentuate or diminish 
the relative heights of data points by pulling the slider at the bottom of the 
window to the right or left.

Note: For multichannel images, you can view each channel 
separately in 3-D. A merged image cannot be displayed in 3-D.

To view the intensity of various bands
1. Select the 3-D button in the display toolbox above the image.

2. Click and drag the model to rotate it into your preferred view.

3. Bring the window into focus by clicking the image.

4. Press “C” to display an inverted green cone, which can be dragged 
around to evaluate the intensity of various bands.

5. Press “C” again to hide the tool.
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Image Info 
The Image Info dialog box provides information about an active image.

Note: For multichannel images, select a channel to display 
details for that image.

IMAGE DETAILS

Acquisition and image information appear in this tab.

ANALYSIS SETTINGS

The settings that were used when the gel was analyzed are displayed here. 
For example, Band Detection and Molecular Weight Analysis will appear, if 
they were performed.

NOTES

You can add notes, point out the types of samples used, and add any other 
information about the results. You can create custom labels for the lanes in 
your image. In a multichannel image, the custom labels are applied to all 
channels.
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Displaying Multichannel Images
The Multichannel View includes a pane that displays the merged channels and 
panes for individual channels. Application names appear in the toolbar. A 
yellow border surrounds the active pane.

In the display toolbox above the image, additional controls are available for 
viewing the multichannel image.
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Multichannel View 
Click the Multichannel View button to display or hide the merged image panel 
in the multichannel display.

You can show or hide each channel using the channel buttons.

You can merge the three channels into a single multichannel pane.

You can also specify the channels to include in the merged view using the 
dropdown list.
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Splitting Multichannel Images
You can work separately on the images that make up the multichannel image 
by splitting the multichannel image into individual image files. When you split 
a multichannel image, a new file is created for each channel (except the RGB 
channel). Each new file has the same name as the multichannel image; the 
application name is appended in parentheses. All acquisition settings and 
overlays are copied to the new files.

To split a multichannel image into separate files
1. Open a multichannel image.

2. Select Split Multichannel Image in the File menu. Each channel is 
displayed in its own window (except the RGB channel).

3. Save each image in its own file.
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CHANGE LAYOUT 
You can choose a layout for the image panes. Clicking Change Layout shows 
a list of display options for the image panes. You can select from one of the 
four views that follow.

Grid View — by default, multichannel images appear in grid view.

Vertical View
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Horizontal View

Single View

Displaying Data
You can view the results from analyzed data associated with the gel images 
using an analysis table, a lane profile, a standard curve, or a report.

Use the buttons in the main toolbar to turn these views on or off. You can view 
your data with all views simultaneously.
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Analysis Table Options 
Numerical data associated with an analysis can be viewed in an analysis 
table. Data from the Lane and Band analysis can be viewed in the Lane and 
Band tab. If volume analysis was performed, these data can be viewed in the 
Volume Table tab.

Clicking Analysis Table opens a tabular display of the data extracted from the 
results. The buttons above the table provide options for displaying and 
exporting analysis table data.

SET WINDOW SIZE

To change the size of your Analysis Table window, move your cursor to the top 
of the window until it changes into a double-headed arrow. Click and drag the 
edge of the window until you can see all of the data.

Note: Resizing the Analysis Table window is restricted when a 
Protocol window is open.

DISPLAY DATA OPTIONS 
The Display Data Options dialog box displays three tabs: Measurements, 
Display, and Export.

Measurements — choose the measurements you want displayed in the 
table. Use the arrows to move the columns between the Not Displayed pane 
and the Displayed pane.

Default display settings — “Move selected lane to top by default” is on or 
off, depending on whether the checkbox is selected. This checkbox is 
selected by default.

Per Measurement Precision — set the precision (decimal places) for the 
measurements in the Lane and Band table and the Volume table.
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Example — shows an example of how measurements will display with the 
selected Measurement and Precision settings.

Export formatting — select checkboxes to include lane headers (Lane and 
Band table tab only) and/or column headers in the exported file.

Export delimiter — select a delimiter option for the exported file.
• Comma delimited
• Tab delimited
• Use other delimiter (user defined)

CHANGE ANALYSIS TABLE ORIENTATION 
This button toggles between two table orientations.

Horizontal — displays the lanes/volumes beside each other, so you can scroll 
through the table from left to right.

Vertical — displays the lanes/volumes on top of each other, so you can scroll 
through the table from top to bottom.

Copy Analysis Table to the Clipboard  — click this button to copy the 
analysis table to the clipboard so you can paste the analysis table into word 
processing or presentation applications. It is best to use the vertical table 
orientation when copying to an 8-1/2 x 11-inch page, to allow the columns 
enough room to display.

Export Analysis Table to a File  — when exported as a CSV file, the data 
file can be opened in a database application.

Export Analysis Table to a Spreadsheet  — you can use Excel’s sorting 
and formula functions to manipulate your data. If you have Excel (PC or Mac) 
or Numbers (Mac) installed on your computer, it opens with your spreadsheet 
displayed.

Lane and Band Definitions
Band Number — each band in a lane has a unique number, sorted from top 
to bottom.

Band Label — you can assign a custom label to each band by clicking the 
Band Label field of the Lane and Band table. 
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Molecular Weight — the molecular weight of the band is calculated based on 
the user-defined standard and regression method. Italic values indicate 
extrapolated values. When using nucleic acid gels, the size of the band is 
displayed in base pairs.

Relative Front — values between zero and one indicate the relative 
movement of the band from top to bottom.

Abs. Quant. — absolute quantification of the band.

Rel. Quant. — relative quantification of the band compared to the reference 
band.

Band % — percentage of the band volume compared to all band volumes in 
the lane.

Lane % — percentage of the band’s volume compared to the entire volume of 
the lane.

Volume Definitions
Volume Number — a unique number is assigned to each volume.

Volume Label — software-generated labels for different types of volumes (U 
for unknown, B for background, S for standard). Label can be changed in 
Volume Properties.

Volume — the sum of all the intensities within the band boundaries.

Adjusted Volume — the background-adjusted volume.

Mean Background — the mean value of the background. 

Absolute Quantity Volume — the quantity of the volume based on the 
standard volumes and the regression method.

Relative Quantity Volume — the ratio of the adjusted volume and the 
adjusted volume of the reference volume.

# Pixels — number of pixels inside the volume boundary.

Minimum Value — intensity of the pixel with the minimum intensity inside the 
volume.

Maximum Value — intensity of the pixel with the maximum intensity inside 
the volume.

Mean Value — mean value of all pixels inside the volume boundary.
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Standard Deviation — standard deviation of all pixels inside the volume 
boundary.

Area — area of the volume in mm2.

Lane Profile 

The Lane Profile option shows a cross-section view of a single lane in the 
channel, rotated 90°. 

To navigate in the Lane Profile window
• Use the Next and Previous buttons at the top of the window to 

page through the profiles of the lanes in your image. 
• Click on a lane in your image to see its profile.
• To view the lane profiles of the different channels in a multichannel 

image, first click on the channel. The Lane Profile window updates 
and displays the lane profile of the selected lane in the channel. 
Then use the Next and Previous buttons to page through the lanes 
in the channel.

The title bar identifies which lane profile is in view (Lane 1, Lane 2, and so on). 
If the image is a multichannel image, the title also includes the name of the 
channel, for example, Lane 2 (Dylight 650).

There are several settings at the top of the window: “Scale to fit graph,” 
“Include Background,” and “Identify Bands by.” These settings, as well as the 
zoom tools, are global and they apply to all the profiles.

Background
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The zoom tools work the same way they work elsewhere in the software. For 
more information, see Zoom Tools on page 57.

In addition to the graph of the lane intensities, the Lane Profile tool also shows 
an image of the selected lane below the graph. The multichannel channel of 
multichannel images is always a gray scale image of the lane with the default 
transform applied to that lane. For single-channel images and individual 
channels of a multichannel image, the transform and color map are applied to 
the gray scale image.

As you move your cursor over the profile, the current relative front (Rf) value 
and the average intensity (Int) value at the Rf value are displayed in the 
lower-right corner of the Lane Profile window.

SCALE TO FIT GRAPH

You can choose the highest point of the display to define the range of the 
graph. This provides the best view of the lane profile.

You may want to clear the Scale to Fit Graph checkbox to display the entire 
range of possible intensity values in the graph. Doing so allows valid 
comparisons between different lanes.

INCLUDE BACKGROUND

When the Include Background checkbox is selected, the Lane Profile window 
shows the subtracted background under the blue line. The area used for band 
quantification appears in green under the red line.

When you clear the Include Background checkbox, the area of the lane profile 
that represents the background of the image does not display.

IDENTIFY BANDS BY

You can change how the bands are labeled by choosing from the options in 
the “Identify Bands by” list. By default, the bands are labeled with the band 
number.

You can display callouts of the following attributes:
• Band Number
• Band Label
• Molecular Weight
• Relative Front
• Volume
• Absolute Quantity
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• Relative Quantity
• Band %
• Lane %
• Normalization Factor (Multichannel images only)
• Normalization Volume (Multichannel images only)

ADJUSTING BAND BOUNDARIES

Below the profile of each lane, there is a strip of blue that displays the bands 
in the channel surrounded by a pair of vertical lines delimiting the boundaries 
of the bands. You can move the vertical lines and change the boundaries of 
the band.

To change the boundaries of a band
1. Hold your cursor over one of the boundary lines until a double arrow 

appears.

2. Drag the cursor to the desired position.

Note: Boundary lines cannot overlap one another. Therefore, 
when you move a boundary line, you will not be able to move it 
beyond the next boundary line.
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Standard Curve 

The Standard Curve dialog box displays the best curve fit for the defined 
standards and the bands relative to this curve for the lane selected in the 
image. The tabs at the bottom of the dialog box display the standard curves 
for three different analyses.

Standards appear in green; unknown bands appear in red. You can toggle the 
molecular weight display on the y-axis between linear and log scale by 
clicking the Log y-axis box at the upper left. The regression method you 
chose in Molecular Weight Analysis Tools appears, as well as the formula (if 
applicable) and the R2 value of the regression method.

Tabs in this window enable you to view the Mol. Weight Standard Curve, the 
Abs. Quantity Standard Curve, or a Volume Standard Curve.

Report 
See Chapter 7, Generating Reports for information about reports.
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6 Analyzing Images
Analysis Toolbox tools are enabled once an image file is opened and in focus. 
An active or “in focus” window has a darker blue menu bar on a Windows PC. 
On a Mac, the window control icons display more brightly when a window is 
active. This distinction helps you to identify the active window among many 
open image files in your workspace.

Image Types
There are three types of images that are created using Image Lab:

• Single-channel images
• Linked multichannel images
• Unlinked multichannel images

The multichannel view in a multichannel image is a merged display of single 
channels. You can have up to three images in the multichannel image. The 
linked multichannel image is acquired using the multichannel protocol. 
Unlinked multichannel images are generated by combining several images 
using the Create Multichannel Image feature.

The Analysis Toolbox tools work differently on these images. Some tools, such 
as lane detection, are applied to one channel in a linked multichannel image 
and the changes are propagated to all the other channels. With unlinked 
multichannel images, lane detection must be applied separately to each 
channel.
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Using Auto Analysis
Auto analysis detects the lanes and bands and, optionally, calculates the 
molecular weight of the bands in your image. Clicking Auto Analysis in the 
Analysis Toolbox enables you to do the following:

• Analyze images obtained with protocols that did not include steps 
for detection and analysis

• Change your analysis parameters to reanalyze your images 
Note: If you change any settings for an analyzed gel, the initial 
analysis is overwritten. To preserve both analyses, save each 
image file with a different name.

AUTO DETECTION SETTINGS
Note: The Band Detection Sensitivity and Molecular Weight 
Analysis Settings are applied to all channels in a multichannel 
image. If you want to use different sensitivity levels to detect 
bands in each channel, use the Lane and Bands Tool.

The band detection sensitivity options are as follows:

Low Band Detection Sensitivity — sets detection at a low level, for images 
with prominent bands. Faint bands are not detected with this setting.

High Band Detection Sensitivity — sets detection at a higher level for 
images that are faint. Extraneous bands can be removed using the Band Tools 
in the Analysis Tool Box. See Lane and Bands Tool on page 80.
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Custom — allows you to set a value between 1 and 100 to select the best 
detection sensitivity for your sample. You can also drag the sliding bar left or 
right to set the value.

When Low Band Detection Sensitivity or High Band Detection Sensitivity is 
used, the following numerical values are set: low sensitivity = 25; high 
sensitivity = 75.

MOLECULAR WEIGHT ANALYSIS SETTINGS

Molecular Weight Standard — choose any of the many Bio-Rad standards 
or other standards you have placed in your standards list.

Standard Lanes — choose or change the lanes in which the standards are 
placed. 

Regression Method — four regression methods are available. For more 
information, see Regression Methods on page 43.

Analysis Toolbox Tools 
All Analysis Toolbox tools customize the analyzed data in image files. These 
tools are available only when an image file is open. Click a specific image to 
select among many windows that may be open in your workspace. On a PC, 
the menu bar of the selected window becomes a darker blue than other 
windows. On a Mac, the window control icons display in brighter color when a 
window is active.

Note: Some tools delete the existing analysis. 

To access a tool
• Click any of the toolbox buttons.

To return to the Analysis Toolbox menu
• Click the green Up arrow to the right of the tool name.
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Image Tools 
To display the image tools menu, click Image Tools.

 

You can manipulate your images using these image tools: 
• Flip — you can flip the gel image horizontally or vertically.
• Rotate — you can rotate the gel image 90 using the Left or Right 

buttons. 
• Crop — you can trim the outer edges of your image.
• Merge — you can merge chemiluminescent blot image with a 

colorimetric image of the same blot.

The sections that follow describe how to use these tools in greater detail.

Correcting a Slanted Gel
To correct a slanted gel

1. Click Custom. 

2. Rotate the red arrows that appear over the gel to any degree between 0 
and 360 by dragging them.

3. Right-click the gel image and choose Rotate to set your gel in the new 
position. You will be prompted to Cancel or Continue, in case you want 
to reset the rotation.

Click to return
to the
Analysis Toolbox
menu
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Cropping a Gel Image
You can save crop settings and use them to crop other images. This feature is 
useful when you want to crop the same area in several images. 

To crop a gel image 
1. Click Crop. A red box outlines the image area.

2. Drag the red box to surround the image area you want to keep. 

3. (Optional) Right-click the image to open the Crop menu and click Save 
Crop Settings. 

4. (Optional) Type a name for the crop settings in the dialog box that 
appears and click OK.

5. Right-click and select Crop or Cancel. Selecting Crop crops the image 
to the area inside the red box.

To crop an image using saved crop settings
1. Click Crop. A red box outlines the image area.

2. Right-click the image to open the Crop menu and click Load Crop 
Settings. 

3. Select the saved crop settings in the dialog box that appears and click 
Load. The red box resizes and the crop specifications appear on the 
image.

4. Right-click and select Crop. The image is cropped to the area specified 
in the crop settings you selected.

To delete crop settings
1. With an image open, click Crop. 

2. Right-click the image inside the red box to open the Crop menu and 
click Delete Crop Settings. 

3. Select the crop settings in the dialog box that appears and click Delete.

Inverting Data
Invert Data is used for negative stains and zymograms. Intensity values of 
bands must be greater than background to perform analysis on the gel. View 
the gel as a 3-D projection to determine if the data must be inverted.
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Merging Images
Use this button to merge a chemiluminescent blot image with a colorimetric 
image of the same blot. If you have used colorimetric prestained standards for 
a chemiluminescent blot, you can acquire an epi-white light image of the blot 
to show the standards and a chemiluminescent image to show 
immuno-detection. These two images can then be merged into a combined 
image with both signals. 

Note: Merging images can have an adverse effect on 
quantification. If accurate quantification is required, perform 
analysis on the original, separate images. Only images of the 
same size can be merged.

Lane and Bands Tool 
The Lane and Bands tool enables you to identify the lanes and bands in your 
images. 

To open the Lane and Bands tool
• In the Analysis Tool Box, click Lane and Bands tool, then select the 

tab for the Lanes tools or the tab for the Bands tools.
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The following is a screen shot of the Lanes tools.

Detecting Lanes
To detect the lanes in the image

Choose one of the following methods to find the lanes in your images:
• Click Automatic if the gel image is fairly typical.
• Click Manual to detect a specific number of lanes or if automatic 

lane detection did not find all the lanes.
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DETECTING LANES IN MULTICHANNEL IMAGES

To use automatic lane detection with multichannel images, select one of the 
channels and click Automatic. Automatic lane detection works differently in 
multichannel images depending on whether the channels are linked or 
unlinked.

• For linked multichannel images, the lane detection is based on the 
selected channel, and the detected lanes are applied to all 
channels. 

• For unlinked multichannel images, lane detection is applied to only 
the selected channel. You must individually select each channel 
and apply automatic lane detection.

The lanes in unlinked multichannel images may fall in slightly different places 
on each channel, and you may want to have more control over where the 
lanes fall. You can detect the lanes in one channel of an unlinked multichannel 
image using either the automatic or manual lane detection tools. Then you 
can copy the lanes into the other channels and position the lanes so that the 
lanes in each channel are matched to one another. For more information on 
copying lanes, see Copying Lanes on page 84.

Using the All Lanes and Single Lane Tools
To use the All Lanes and Single Lane tools

• Click the lane tool first, then click the lane that you want to apply 
the change to.

More specific information on how to use each lane tool is described in the 
following sections. Tool actions in linked multichannel images are applied 
across all channels. Tool actions in unlinked multichannel images are applied 
in only the selected channel.

All Lanes Tools
The All Lanes tools are described below:

• Resize — a square anchor point appears in each corner of the 
image. Drag the handles of the red squares to resize all lanes.

• Adjust — if the gel image is irregular, you can adjust the orientation 
of all lanes by dragging a single corner of the lane frame. The 
Adjust All Lanes tool does not resize lane width.
You can add additional anchor points to the top or bottom borders of 
the rectangle by clicking the lane frame. Remove any unneeded anchor 
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point by right-clicking it. By dragging these anchor points, you can 
adjust for “smiling” gels.

• Delete — deletes all lanes.
• Move Lane Frame — you can move the entire lane frame when 

resizing or adjusting the lanes. Click Resize or Adjust and make the 
changes to your lanes. Then click anywhere in the frame and move 
it to the desired location. 
Tip: On the PC, you can hold down the Shift key or the Ctrl key 
and use the arrow keys on your keypad to move the lane frame. 
On the Macintosh, hold down the Shift key or the Command key 
and use the arrow keys.

• Width – Drag one of the anchor points on any lane to change the 
width of all lanes at once. In a multichannel image, the width of all 
of the lanes in all channels are changed.
Note: The All Lanes Width tool makes the width of all lanes 
uniform. Therefore, if you used the Single Lane tool to change the 
width of an individual lane, this change is overridden by the All 
Lanes Width tool.
Tip: You can use the plus key (+) on your keyboard to increase 
the lane width and the minus key (-) to decrease the lane width.

Single Lane Tools
The Single Lane tools are described below.

• Add — adds a lane to a gel image. Click Add, then click within the 
lane frame where you want to place the new lane. The lanes are 
automatically renumbered. 
Note: To add a lane outside the frame, add a lane inside the 
frame and click Move to expand the lane outside the frame’s 
boundaries.

• Delete — deletes a lane. Click Delete, then click either the lane or 
its lane number. The lanes are automatically renumbered.

• Bend — bends a lane to better fit the gel image. Click Bend, then 
drag one of the square anchor points to fit the image. 
Note: 
• To add additional anchor points, left-click within the lane. Drag 

these anchor points to adjust the lane to fit the gel image. 
• To remove and anchor points, right-click on the anchor point.

• Move — moves a lane to a new position on a gel image. Click 
Move, then click the lane you want to move. Drag it to a new 
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location. The lanes are renumbered according to their new 
position.

• Width — changes the width of a lane. Click Width, then click within 
the lane. Click on the anchor points to adjust the lane width.

Copying Lanes
You can copy the lanes from one channel into any other channel. This tool is 
useful if you want to create a multichannel image from unlinked images, and 
you want to identify and match the lanes in your channels.

To use the copy lanes feature, you must open the Lane and Bands tool. The 
entire frame and all the lanes are copied; individual lanes cannot be copied.

To copy lanes between channels
1. Open the Lane and Bands tool.

2. Select the channel that contains the lanes you want to copy.

3. From the Edit menu, select Copy.
The message, Copying All Lanes, is displayed briefly.

4. Select the channel that you want to copy the lanes into and from the 
Edit menu, select Paste.
A channel can contain only one lane frame at a time. Therefore, if you 
paste lanes into a channel that already contains a lane frame, you are 
prompted to confirm the deletion of the existing lanes. If you click Yes, 
the existing lanes are deleted and replaced with the copied lanes.
Note: If you copy lanes into a channel of a linked multichannel 
image, the lanes are copied into all channels of the image, 
including the Multichannel channel.

Once the lanes are copied into the channel, you can manipulate individual 
lanes using the lane tools so that they are correctly positioned.

Using Lane Background Subtraction
Perform lane-based background subtraction by selecting Enable Subtraction 
in the Background Subtraction field. Use the Lane Profile view to see the 
subtracted lane background.
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Rolling Disk — specifies the size of a hypothetical rolling disk (between 1 and 
99 mm) that removes background levels along the length of the lane. The size 
of the disk determines how closely the background level follows the intensity 
profile. 

A large disk follows the profile trace less closely, touching fewer points along 
the trace and removing less background. A smaller disk more closely follows 
the profile trace, removing more background.

A disk radius that is too large will result in poor background removal. A disk 
radius that is too small may subtract actual data. For most samples, a size of 
<10 mm is usually appropriate. You can perform this task several times until 
you are satisfied with the amount of background removed. Use the Lane 
Profile tool to evaluate the appropriate disc size for background subtraction. 

Apply to selected Lane — when you select this box, the level of background 
subtraction specified with the previously described buttons is applied only to 
the selected lane. This option enables you to set different background 
subtraction levels for each lane.

Detecting Bands
Bands are detected for individual images. For multichannel images, you must 
detect the bands for each channel, one at a time. This applies whether the 
multichannel image is linked or unlinked.

Note: Band detection on the multichannel channel is disabled. 
The multichannel view is a composite of the other channels. 
Detecting bands in this view is not particularly useful because 
quantification of overlapping bands will result in combined values 
from multiple channels. 

The following is a screen shot of the Bands tools.
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To detect bands in the image
• Click Detect Bands. The Band Detection dialog box opens in which 

you can select band detection sensitivity and the lanes to which it 
applies.
Note: With multichannel images, you can leave the Band 
Detection dialog box open as you select each channel one by 
one and detect the bands in each channel. You do not have to 
close and reopen the dialog box for each channel.

EDITING THE DETECTED BANDS

Several tools are available to optimize the bands in your images.
• Add — adds a faint band. Click Add, then click anywhere within 

the lane. Image Lab then looks for a faint band close to where you 
clicked. You can darken your entire image to view faint bands more 
easily using the Gamma slider in the Image Transform dialog box.
Note:  For instructions, see Image Transform on page 58.

• Delete — deletes a band from the image. Use this feature to 
remove bands that are not relevant to your analysis. Click Delete, 
then click on the band you want to remove.

• Adjust — adjusts the height of a band. Click Adjust. Two boundary 
lines appear around each band. Move the cursor over a boundary 
line until you see a double-headed arrow. Move the boundary line 
up or down; the center recalculates and the band appears there.
Note: You can also adjust band boundaries in the Lane Profile 
view.
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Normalizing Volume Data
There are several reasons why you might want to normalize the volume data in 
multichannel images:

• The lanes are loaded with the same volume; however, you do not 
know the total protein in each lane.

• Pipetting errors result in variations in the lane volumes.
• Differences occur in the transfer of protein from the gel to the 

membrane.

In these instances, you can correct for these differences by normalizing the 
volume data. There are two ways to normalize volume data:

• Total Lane Protein Normalization – one lane in the normalization 
channel is used to calculate the normalization factor. 

• Housekeeping Protein Bands Normalization – a single band of a 
housekeeping protein is used to calculate the normalization factor. 
In order to get accurate results, the housekeeping protein must be 
stable and impervious to the treatments in your experiment. It must 
be the same in pre-treatment and post-treatment. 

In both cases, the normalization factor is then used to calculate the 
normalized volumes in the lanes for all channels.
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Using the Normalization Tool 
Click Normalization on the Analysis Tool Box.

The Normalization Steps outline the recommended steps to follow. You will 
need to review your lanes and bands and possibly make adjustments to them. 

Tip: From the Normalization tools pane, click Adjust Lanes/
Bands to quickly navigate to the Lane/Bands Tool.

See Optimizing Normalization of Volume Data on page 89 for an explanation 
of each step in the process.

The Normalization Steps guide you through 
the steps to normalize your volume data.
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Optimizing Normalization of Volume Data
The following are the steps you should follow to get the best results when 
normalizing your volume data:

1. Detect the Lanes in the Channels (page 89).

2. Make Adjustments to the Lanes (page 90).

3. Detect the Bands (page 91).

4. Subtract any Extraneous Background (page 92).

5. Remove Compromised Data (page 92).

6. View the Data in the Analysis Table (page 93).

Detect the Lanes in the Channels
Start by detecting the lanes in your multichannel image. You can either use 
the automatic or manual lane detection method. For more information on 
when to use each method, see Lane and Bands Tool on page 80. If your 
multichannel image consists of unlinked images, you will need to pay 
particular attention to the lanes that are detected to ensure that the 
corresponding lanes are correctly mapped for each channel. For example, you 
may want to use the Copy Lanes tool to map your lanes. For more information 
on Copy Lanes, see Copying Lanes on page 84.



ChemiDoc MP | Analyzing Images

90

Make Adjustments to the Lanes
Regardless of which method you use to detect your lanes, you should review 
the lane borders to ensure that each lane encompasses all the protein in a 
particular lane, and that the lane does not overlap into another lane. For 
example, in the following figure, lanes were detected using the automatic lane 
finder. Some of the lanes exclude material that should be included.

Note: Image Lab automatically excludes standard lanes from 
normalization.
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Use the Lanes tools to make the necessary adjustments to your lanes. For 
more information on these settings, see Using the All Lanes and Single Lane 
Tools on page 82. In this example, the lanes were slightly widened to include 
the relevant material. The corrected image follows.

Detect the Bands
Use the band detection tool to detect the bands in the channels. If you are 
using the total lane protein method to normalize your data, it is recommended 
that you do not use the band detection tool on the normalization channel, 
because this will generate large amounts of superfluous data in the analysis 
table. For more information, see Detecting Bands on page 85.

If you are using a housekeeping protein to calculate the normalization factor, 
you must isolate this protein in your image. Remove all bands other than the 
housekeeping protein from your image. The normalization channel should 
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have only one detected band in each lane. Use the Delete Bands tool to 
exclude all other bands from the calculation.

Subtract any Extraneous Background
The lane volume data is background subtracted. Review the background 
subtraction being applied to each lane by using the Lane Profile tool. Verify an 
equivalent background profile is being subtracted from each lane in the 
normalization channel so the normalization factor is accurate. For more 
information on the lane Background Subtraction tool, see Volume Background 
Subtraction on page 112.

Remove Compromised Data
There are several reasons why lanes should be excluded from your analysis:

• Empty lanes — the first nonstandard lane in the selected channel 
is used as the normalization factor against which all other lanes in 
all the channels are compared. If the first nonstandard lane is not a 
valid lane (for example, an empty lane), delete it from the channel.
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• Lanes contain saturated pixels— check your images for 
saturated pixels, indicated by red. These points cannot be read 
and cannot be used in quantification.

• Poor transfer quality — check the quality of the transfer. If the 
transfer is poor with splotchy or blurred areas, delete these lanes.

View the Data in the Analysis Table
The first nonstandard lane in the selected channel is used as the normalization 
factor against which all other lanes in all the channels are compared. The 
normalization values are calculated based on the total background-corrected 
signal in the selected channel.

The Analysis Table displays the uncorrected and normalized volumes, as well 
as the normalization factor used to calculate the normalized volume.

Tip: Omit the normalization channel from the Analysis Table using 
the Multichannel View button. (See Displaying Multichannel 

Saturated Pixels
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Images on page 63 for information on displaying and hiding 
channels.)

Adding a Channel to a Single Image
The Normalization tool can be used only with multichannel images. If you 
have a single image, there is an Add Channel feature in the Normalization 
tools pane that guides you through the process of creating a multichannel 
image. Once the multichannel image is created, you can use the tool to get 
normalized values.

To use the Normalization tools with a single image
1. Click Normalization in the Analysis Toolbox.
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2. Click Add Channel to open the Add Normalization Channel window.
Note: The image that is selected when you click Add Channel is 
the first image in your multichannel image.
The selected image appears as the first image in the Sample Data field.

3. To add a second image, double-click on an image from the Compatible 
Open Images list.
If no images appear in the list or you want to use a different image, click 
Browse to navigate and select the desired image.
Note: Image Lab checks to see if the image has the same aspect 
ratio as the Sample Data image. If the aspect ratio is not 
compatible with the Sample Data image, it will not appear in the 
list of Compatible Open Images. The aspect ratios may not be 
compatible if they were created using different instrument models 
(for example, Gel Doc EZ and ChemiDoc MP) or if the images are 
cropped at different aspect ratios.
Tip: You can move an image to the Normalization Data box by 
dragging it from the Compatible Open Images list, and you can 
remove it by dragging it back to the list.

4. Click OK.
The Auto-Analysis window appears prompting you to detect the lanes 
and bands in your images.

5. In the Auto-Analysis window, select the level of sensitivity and click OK.

6. Follow the Normalization Steps listed in the pane to get the best results.
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See Optimizing Normalization of Volume Data on page 89 for an 
explanation of each step in the process.

Molecular Weight Analysis Tools 
Molecular Weight Analysis Tools enable you to determine molecular weight (or 
base pairs, if using nucleic acid gels) by comparing a test sample with known 
standards.

Note: Before you can use the Molecular Weight Analysis Tools, 
you must detect the lanes and bands in each channel in your 
image.

You can view each band’s molecular weight in the molecular weight column of 
the Lane and Band tab in the Analysis Table view.
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You can also display the molecular weight of the bands on the gel image by 
opening the Display Gel Options window and selecting Mol. Wt from the Band 
Attributes section. (See Displaying Gel Images on page 56 for information on 
displaying band attributes.)
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MOLECULAR WEIGHT STANDARD

You can change the standards that determine the molecular weight of test 
samples. 

Click Change to access the Manage Standards dialog box, where you can 
choose another standard or add your own standards. 
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STANDARD LANES

Standard samples are placed in the first and last lanes by default. You can 
specify other standard lanes by selecting the box below each lane or by 
entering the standard lane numbers separated by commas. In the Lane and 
Bands view, Std appears below the lanes, identifying them as standard lanes. 
In the Molecular Weight Analysis view, these lanes are indicated with a check 
mark below the lane.

MOLECULAR WEIGHT ANALYSIS IN SINGLE-CHANNEL IMAGES

The screen shot below shows a single channel with the molecular weight 
calculated. There are three standard lanes on both ends of the frame (lanes 1, 
16, and 17). Standard lanes are identified with a check mark in the boxes 
below the lane. The molecular weights of the bands in the standard lanes 
appear on either side of the lane frame. The red lines running from one end of 
the lane frame to the other end identify the location of the bands in the 
standard lanes. You can use these lines to see where the bands in the other 
lanes fall relative to the bands in the standard lanes.

Note: You can use the lane labels to identify your standard lanes.
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The screen shot below shows the molecular weight for the first four lanes in 
the image. The values for the molecular weight in any standard lane appear in 
bold. In this example, the values for the first lane are in bold. (Lanes 16 and 17 
are not included in the screen shot, but their values would also be in bold.) 
The molecular weight of the bands in the remaining lanes are calculated 
relative to these standards.

MOLECULAR WEIGHT ANALYSIS IN MULTICHANNEL IMAGES

Molecular weight analysis is performed differently in multichannel images 
depending on whether the channels of the image are linked or unlinked. If the 
channels are linked, then the standard lanes are synchronized across all 
channels. If the channels are unlinked, each channel has its own standard.

When you select the standard lane in one channel of a linked multichannel 
image, the same lane is selected as the standard in all other channels. The 
combined data in the multichannel image is used to detect the bands in this 
standard lane and these bands are synchronized across all channels. All the 
bands in all the channels are calculated using the same standard lane. If you 
deselect this lane as the standard, the bands in the standard lane are deleted 
from all channels, including the multichannel image. 

With unlinked multichannel images, each channel is treated independently as 
if it were a single-channel image. You select a standard lane for each channel 
and the molecular weight is calculated for only the bands in that channel. 

In the following screen shot, lane 1 in the linked multichannel image is 
selected as the standard lane for all channels. Because the images are linked, 
the same molecular weights for the standard lane and the same red lines 
showing the location of the bands in the standard lane are displayed in all 
channels.
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The molecular weights of the bands in the three channels are calculated 
based on standards established in lane 1 and are displayed in the analysis 
table.

REGRESSION METHODS

There are four regression methods. See Regression Methods on page 43.
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Quantity Tools 
You can quantify bands in test samples automatically using either the Relative 
or Absolute tabs under Quantity Tools.

RELATIVE QUANTITY TAB

To compare the relative quantities of bands, first select the Relative tab.

To select a reference band from an image and quantify all other bands 
relative to it

1. Click the Select button.

2. Click the band you want to use as a reference. A small R appears near 
the band you selected. 

To review the relative band quantities
• Go to the Rel. Quant. column of the Analysis table (Lane and Band 

tab). The relative quantity is the ratio of the band volume divided by 
the reference band volume.



Quantity Tools

103

All other bands now display numerical values that are relative to the reference 
band. Values above 1.00 indicate that the band quantity is greater than the 
reference band. Values below 1.00 indicate the band quantity is less than that 
of the reference band.

ABSOLUTE QUANTITY TAB

Absolute quantification is used to quantify bands based on known standard 
bands using a calibration curve. To determine the absolute quantities of 
bands, first select the Absolute tab.
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To calculate the absolute quantities of the bands
1. Click Select.

2. Select at least two standard (known) bands and assign quantity values. 
The values display in the Standard Bands table. The greater the number 
of known bands and the wider the range of their values, the more 
accurate the absolute quantity calculation of the unknown bands will 
be.
Note: Any standard band selection can be deleted. To do so, 
select the entry in the Standard Bands field by clicking it and then 
clicking Delete.

3. Select a unit of measure from the choices listed in the Units dropdown 
list. 

4. Select a regression method from the dropdown list. 

Keep the following guidelines in mind while making your choice.

Linear — generates a straight line that is the best fit of the values you 
provided and is preferred in most cases. 

Point-to-point — generates a curve in which each data point is 
connected directly to the next, regardless of the shape of the resulting 
curve.

Cubic spline — generates a smooth curve that connects each data 
point. At least four standard points are required to use this method of 
least-squares polynomial fits.

5. Click Standard Curve in the toolbar, select the Absolute Quantity 
Standard Curve tab, and a calibration curve displays. Standards are 

Regression Method
Minimum Number of 
Standard Bands

Minimum Number with 
Force Through Origin 
Option

Linear 2 1

Point-to-point 2 1

Cubic spline 5 4
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represented by green triangles. Unknown values are represented by red 
triangles.
Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.

Note: Clicking the Standard Curve table generates a crosshair 
tool that displays the numerical values associated with the 
placement of the cursor in the graph.
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Annotation Tools 
You can annotate results with text and arrows to draw attention to areas of 
interest.

Add Annotations
• Text — you can add text annotations to gel images to draw 

attention to important details. First click Text, and then click an 
area you want to emphasize. A text box appears with a dotted-line 
border. Type your comment in the text box. Drag the box to change 
its position.
Note: While editing text, press SHIFT+ENTER to add text. This 
adds a new line in the annotation.
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• Arrow — to add an arrow, first click Arrow. Click the area where 
you want the arrow to start and then drag to stretch the arrow point 
to the location you want to emphasize. To move the arrow, click the 
middle and drag it. To change where the arrow points, click either 
end of the arrow. Square boxes appear; drag a box to change the 
length or orientation of the arrow.
Note: In multichannel images, you can add annotations in all the 
channels. Each annotation including the merged channel is 
channel specific.

Alignment
Alignment Buttons — these buttons enable you to align multiple annotations, 
such as lane numbers, which you have manually added.

To select annotations — you can select several annotations by holding down 
the CTRL key (Command key on the Mac) and clicking each one or by 
dragging a selection box around them.

To copy annotations — you can copy annotations within or between images. 
First select the annotation you want to copy. Then press CTRL+C to copy the 
annotation and CTRL+V to paste it.

Note: In multichannel images, you can also copy annotations 
from one channel to another using the same method.

Text Properties
You can change the size and type font of your text annotations. To select 
multiple items for change, hold down the CTRL key (Command key on the 
Mac) and click each item.

• Font — first click the text box you want to change. Then open the 
dropdown Font menu to show all fonts installed on your system. 
Click one of the font names to change the font of the text 
annotation.

• Size — first click the text box you want to resize. Click the 
dropdown Size list to increase or decrease the size of the text. You 
can set the font size between 6 and 72 points using the dropdown 
list. 
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Color
You can change the color of text annotations to make them visible with any 
color scheme and emphasize them further by adding a color to the 
annotation’s background, which is invisible by default. 

To change the color of multiple items, hold down the CTRL key and click each 
item.

• Foreground — click a text annotation or arrow. This activates the 
Foreground field, so you can select a foreground color from the 
dropdown list.

• Background — click a text annotation. This also activates the 
Background field so you can select a background color from the 
dropdown list.

Rotate
You can rotate text annotations 90 to the left or right by clicking the Rotate 
buttons.
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Volume Tools 
Volume tools enable you to manually quantify features on a sample image 
when automated lane and band analysis is not appropriate or possible, such 
as in dot blots. 

Note: The analysis table displays the color-coded volume drawn 
for each channel of a multichannel image. In multichannel view, 
you can draw a volume on individual panes, but you cannot draw 
a volume on the multichannel pane. 

You can use Volume tools to quantify the signal intensity of bands, spots, 
arrays, and other image data. Define an area of interest by surrounding it with 
a shape. You can choose a rectangle, circle, freehand, or lane shape by 
clicking the appropriate button under the Volumes field. 
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A default label appears within the shape drawn. The volume label can be one 
of three types—U for unknown, Std for standard, or B for background—along 
with a number that is assigned sequentially.

Each new volume you create initially has a red border, which indicates that the 
volume is selected. When you click elsewhere on the image, the border 
changes to blue, indicating that the volume is no longer selected.

Note: Double-click a volume area to change its properties. 

To review data for the volumes
• Open the analysis table and select the Volume tab. Volumes are 

listed based on their number and/or the associated information per 
volume. See Volume Definitions on page 70.
Note: In multichannel images additional column bars, channel 
numbers, and volumes are color-coded based on their channel 
association. 
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VOLUME TYPES

You can define the volume type (unknown, standard, or background), the 
quantity of standard volumes, or enter a custom name to replace the default 
label.

Unknown volumes are volumes you want to quantify. 

Standard volumes are used for absolute quantities. See Absolute Volume 
Quantity on page 113. 

Background volumes are used to remove the background from the 
calculation. The result of volume background subtraction appears in the 
Adjusted Volume column of the analysis table (Volume Table tab).
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VOLUME BACKGROUND SUBTRACTION

When you draw a volume, some nondata background pixels may be included 
inside the volume. These background pixels usually have an intensity value 
that you do not want to include in your volume quantification. There are two 
ways of calculating this background intensity for your volumes: local and 
global.

• Local — local background subtraction calculates a separate 
background intensity for each unknown and standard volume you 
create. For each volume, the intensities of the pixels in a 1-pixel 
border around the volume are added together and divided by the 
total number of border pixels. This gives an average intensity for 
the background around each, which is then subtracted from the 
intensity of each pixel inside the volume. If the background value is 
greater than the pixel value inside the volume, the background-
adjusted quantity of the volume may be <0. In this case, redraw the 
border for this volume.

• Global — global background subtraction calculates a single 
background intensity for the entire gel. This average background 
intensity is then subtracted from all the volumes in the gel. The 
average intensity of the pixels in the background volume is 
calculated and subtracted from each pixel in all standard and 
unknown volumes. Therefore, it is not necessary for the 
background volume area to be the same size as your unknown.

To calculate global background subtraction
1. Use one of the Volume Tools to create a volume in a representative 

background region of your image (that is, a nondata region similar to 
the background surrounding your data).

2. Double-click the volume. This opens the Volume Properties dialog box.

3. Select the Background option button. 

Notes:
• If you select Global in the Volume Tools toolbox but do not define a 

background volume as described, no background subtraction is 
performed.

• If you create more than one background volume, all the pixels in 
those background volumes are used to calculate the average 
background. Your background volume(s) will have default names 
B1, B2, and so on based on the sequence in which they were 
created.
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• If the region you defined as background has a higher average 
intensity value than your data object, you obtain a negative value 
for your adjusted volume in the analysis table. If this happens, 
select a new background region with less intensity than your data 
object.

RELATIVE VOLUME QUANTITY

You can choose any one volume as a Reference Volume by selecting the 
Reference Volume checkbox in the Volume Properties dialog box. The 
Reference Volume is indicated by an asterisk on the volume label, for 
example, U1*.

Relative quantities are displayed in the Relative Quantity column in the 
analysis table (Volume Table tab). The relative quantity is the ratio of the 
background-adjusted volume divided by the background-adjusted reference 
volume.

All other volumes now display numerical values relative to your reference 
volume. Values above 1.0 indicate that the volume is greater than the 
reference volume. Values below 1.0 indicate the volume is less than the 
reference volume.

ABSOLUTE VOLUME QUANTITY 
Note: Absolute volume quantity analysis is not available for 
multichannel images. 

If you have drawn your volume around an object of known quantity, you can 
use it to calculate the quantity of your unknown volumes. The quantities of 
your unknown volumes are calculated based on the standard volumes and the 
selected regression method.

To classify a particular volume as a standard
1. Double-click the volume. This opens the Volume Properties dialog box.

2. Select the Standard option button and enter the quantity in the Quantity 
box. 

3. Click OK to close the dialog box. 

Standard volumes will have the default names S1, S2, and so on, based on 
the sequence of their creation. 

To review the regression curve
• Open the Standard Curve window and select the Volume Standard 

Curve tab.
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REGRESSION METHODS

Three regression methods are available to generate the volume quantification 
curve used for absolute quantity: linear, point-to-point, and cubic spline. To 
display the standard curve, click the Standard Curve button in the toolbar and 
select the Volume Standard Curve tab in the Standard Curve dialog box. See 
Regression Calculation Methods to learn how each of these methods is 
calculated.

The data for volume standards are found in the Absolute Quantity column of 
the Volume Table. 

Note: Selecting the Force Through Origin checkbox always starts 
the standard curve graph at 0,0, regardless of the best curve fit.

ALIGNMENT

Align volumes by using the appropriate alignment button. To select several 
volumes, CTRL-click each one or drag them to use a selection box.

Copy and paste selected volumes by pressing CTRL+C to copy. Press 
CTRL+V to paste. 

When you click the Standard Curve button in the toolbar, a chart displays all 
unknown and standard quantities.
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7 Generating Reports
After viewing results, you can generate a report that displays the analyzed gel 
images, all of the settings used in the protocol, and as much information 
about the data as you want to include.

The print report settings can be chosen with the Report Settings dialog box in 
the Edit menu or by clicking Report in the main toolbar. 

Report 
Click Report to produce a Print Preview of your report.



ChemiDoc MP | Generating Reports

116

Clicking Print sends all of the above information to a printer. 

Use the following dialog boxes to remove information from reports. Doing so 
does not delete the data from the analysis.

General Tab 
By default all information is included, but you can customize reports here.

Clear any of the following settings to exclude information from a report.

Custom Report Title — you can provide a custom report title for the report.

Include Gel Image — the following options determine which overlays display 
on the gel image.

• Show Lanes and Bands
• Show Volumes
• Show Annotations
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Image Info
• Acquisition Information
• Analysis Settings
• Image Information
• Notes

Lane and Band Table Tab

Clear any of the following settings to exclude information from the report.

Include Lane and Band Table

Lanes to show 
• All lanes or only user-defined lanes
• All lanes on one page, or one lane per page (add page break after 

each lane)

Show Lane Profile — includes the lane profile for each lane.

Not Displayed/Displayed — move items that you do not want to include in 
the report to the left column.
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Volume Table Tab

Include Volume Table — clear to exclude this information from your report.

Not Displayed/Displayed — move items that you do not want to include in 
the report to the left column.

Print Report 
Click the Print Report icon to print your report. 

Print Report to .pdf File 
The Print Report to .pdf File icon brings up a Save dialog box so the .pdf file 
can be saved on your system.

Adjust the Printer Settings 
The Printer Settings icon accesses options for paper size, orientation, and 
page margins.
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8 Exporting Results
The most convenient way to archive complete information about experiments 
is to produce reports. However, you may want to export only gel images or 

analysis table data for analysis in different programs, such as Quantity One, 
FPQuest™, or InfoQuest™FP software. Or you may need exported files for 
presentation or publication. 

Exporting Gel Images
Image Lab™ software includes features for exporting gel images several 
ways. 

• You can export displayed image data to a publication (choose 
Export for Publication).

• You can export raw image data as a 16-bit TIFF file (choose Export 
for Analysis).

• You can export image data to PulseNet; doing so reduces the 
image to an 8-bit TIFF file, limits its resolution, and restricts its file 
size to 300 Kb.

• You can export lane and band tables as well as volume tables to a 
spreadsheet program or to a file.

The options to export gel images are available using the Export option in the 
File Menu.
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The available export options are described in the following sections.

Exporting Gel Images for Publication
Use this format only to export visual information to presentation or word 
processing software, such as PowerPoint or Word.

When you select File > Export > Export for Publication, you can export a 
displayed image to a file. You can select from .bmp, .png, .jpg, and TIFF 
formats. The gel displays with any lanes, bands, and annotations that appear 
on the screen.

Note: For a multichannel image, select the image pane you want 
to publish before exporting the image for publication. Image Lab 
software exports the active pane.
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Note that you can select the entire image or the current view, select the 
resolution or specify a custom resolution, specify the publishing dimensions, 
and view the resulting published image size and dimensions. 

You can zoom in on an area in a current view to export only that area, or you 
can export the entire image. You can exclude annotations or overlays by 
clicking Display Gel Options in the toolbar to access the appropriate settings.
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Exporting Gel Images for Analysis
When you select File > Export > Export for Analysis, you can export full image 
data (raw data only) for analysis as a 16-bit TIFF file. 

Note: 16-bit TIFF images are not compatible with all image 
viewers.

The image may require contrast adjustment when it is imported into analysis 
software. This option creates a file that can be analyzed in other programs 
such as Quantity One, FPQuest, or InfoQuestFP software. 

Note: For multichannel images, Image Lab software exports the 
separate channel images, but not the multichannel image. Each 
exported channel image is saved with its application name 
appended to the filename you selected.

Exporting Gel Images to PulseNet 
International
When you select File > Export > Export for PulseNet, Image Lab software 
reduces the image to an 8-bit TIFF image file. Resolution is limited and file 
size is restricted to 300 Kb. 

Note: Export for PulseNet is not available for multichannel 
images.

Exporting Lane and Band Tables to Excel
If you have Excel (or Numbers on a Macintosh) installed on your computer, 
choosing File > Export > Lane and Band Table to Excel opens a table directly 
in the spreadsheet program. You can then use the Save As option to produce 
other formats.

Exporting Volume Tables to File
Choosing Export > Volume Table to File exports as a CSV file so the data file 
can be opened in a database application. 
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Screenshot Tool Export 
Use the Screenshot tool, available in the toolbar, to capture a displayed image 
to the clipboard or to save it to a file (.bmp, .gif, or .png). 

Analysis Table Export
You can export table analysis data from the File menu or by using the export 
buttons at the top of the Analysis Table window. 

The Analysis Table window has several buttons to export data to different 
formats, depending on how the data are to be presented.

COPY ANALYSIS TABLE TO THE CLIPBOARD 
Click this button to copy the analysis table to the clipboard and then paste the 
analysis table into word processing or presentation applications. It is best to 
use the vertical table orientation when copying to an 8.5 x 11-inch page to 
accommodate the columns.

EXPORTING ANALYSIS TABLE TO A FILE 
This button exports an analysis table as a CSV (comma-separated values) file, 
so your data file can be opened in a database application.

EXPORT ANALYSIS TABLE TO A SPREADSHEET 
This button enables you to use Excel’s sort and formula functions with your 
data. If you have Excel (or Numbers on a Mac) installed on your computer, the 
data open in the spreadsheet program.
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9 Maintenance
This chapter includes instructions for maintaining the universal hood in proper 
working condition by replacing parts.

UV Transilluminator Lamp and Starter 
Replacement

Note: The UV filter surface should always be kept clean from the 
chemical agents used as gel dyes. Use protective gloves when 
touching the UV transilluminator cover. 

Depending on usage, the UV bulbs and starters last for many years. Replace 
bulbs when you notice them flickering. If a bulb does not turn on when it is 
new or moved, replace the bulb starter and test the bulb again.

Three types of bulbs are available. The catalog numbers are listed in Ordering 
Information on page 118. The standard bulb is 302 nm. Optionally, the 254 nm 
bulb is used for cross-linking of protein, and the 365 nm bulb is used to 
minimize denaturing of DNA.

To replace the lamps
1. Turn off the power.

2. Disconnect the power cord from the universal hood.
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3. Remove the four screws located on the left/right sides of the 
transilluminator cover.

4. Remove the cover with the UV glass by sliding it forward, then lifting up.

5. Place it on a nonabrasive surface so that the glass does not get 
scratched or damaged.

Note: Do not put the UV cover directly on the bench. Wear gloves 
when touching the lamps.

6. Rotate the lamp until it becomes loose and the pins come to a vertical 
position.

7. Remove the lamp. Install the new lamp by rotating so that the pins are 
horizontal and the lamp is tight. 

8. Refer to the pictures above to replace a starter. Remove the starter by 
rotating it counterclockwise, and then pull it out.

9. To replace a starter, insert it into the holder and rotate clockwise.

10. .Reassemble the cover and retighten the screws on both sides.
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Fuse Replacement
Always unplug the instrument before changing or checking the fuses.

This unit is protected by 2 fuses (5 x 20 mm, 2 A Slo-Blo). The fuses are 
located in fuse holders housed in the power entry module. This module is 
located on the right side of the back of the universal hood.

To replace the fuses
1. Unplug the main power cable from the power outlet.

2. Use a flat screwdriver to turn the slotted front of each fuse holder 
counter clockwise; the holder pops out so you can extract the fuse.

3. Remove the blown fuses and replace them with two new ones (catalog 
#900-8935).

4. Slide each fuse holder into the power entry module until it snaps in 
place.

Fuse holders



ChemiDoc MP | Maintenance

128



129

A Using the Criterion
Stain Free™ System

The Criterion Stain Free system comprises the ChemiDoc™ MP imager, Image 
Lab™ software, and three types of precast gels:

• Criterion™ TGX Stain-Free™
• Criterion Stain Free 

• Mini-PROTEAN® TGX Stain-Free™ 

The stain-free system eliminates the time-consuming staining and destaining 
steps required by other protein detection methods. Stain-free gels include 
unique trihalo compounds that allow rapid fluorescent detection of proteins 
with the ChemiDoc MP imager—without staining. 

The trihalo compounds in the gels react with tryptophan residues in a UV 
light–induced reaction to produce fluorescence, which can be easily detected 
by the ChemiDoc MP imager within gels or on low fluorescence PVDF 
membranes. Activation of the trihalo compounds in the gels adds 58 Da 
moieties to available tryptophan residues and is required for protein 
visualization. Proteins that do not contain tryptophan residues cannot be 
detected using this system. The sensitivity of the stain-free system is 
comparable to staining with Coomassie Brilliant Blue for proteins with a 
tryptophan content >1.5%; sensitivity superior to Coomassie staining is 
possible for proteins with a tryptophan content >3%.

Benefits of the stain-free system include:
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• Elimination of staining and destaining steps for faster time to 
results

• No background variability within a gel or between gels (as is often 
seen with standard Coomassie staining)

• Elimination of the need for acetic acid and methanol in staining and 
destaining, which reduces organic waste

• Visualization of transferred or blotted proteins on low fluorescence 
PVDF membranes

Stain-Free Workflow
For detailed information about the Activate/image gels step, refer to Chapter 
4, Acquiring Images, on page 25. For all other workflow steps, refer to the 
Criterion™ Precast Gels Instruction Manual and Application Guide or to the 
Mini-PROTEAN® Precast Gels Instruction Manual and Application Guide.

Prepare buffers

Prepare gels and assemble
electrophoresis cell

Prepare and load samples

Perform electrophoresis

Activate/image gels

Analyze the separation
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Electrophoresis with Stain-Free Gels
Stain-free gels are made and packaged without SDS so they can be used for 
both SDS and native PAGE applications.

To perform electrophoresis with these gels, prepare the sample and running 
buffers, set up the electrophoresis cell, and perform the run.

Imaging Gels
Use unstained standards with stain-free gels, as some prestained standards 
are not detected by the stain-free system. To monitor electrophoresis, use a 
1:1 mixture of unstained and prestained standards.

Setting up a protocol for stain-free gels is very similar to setting up protocols 
for other applications. Follow the instructions in Creating a Protocol, on 
page 29. Choose one of the following activation times based on your sample 
and the purpose of your experiment:

• Gels used in blotting — use 1 min activation for optimal results 
when using western blotting followed by immuno detection.

• Good sensitivity – use 2.5 min activation when samples are 
abundant and when a fully optimized signal-to-noise ratio is not 
necessary.

• Best sensitivity – use 5.0 min activation for detection of proteins 
that are in low concentration and for the best quantification of the 
maximum number of bands. Because the reaction is near 
completion after 5 min, this method offers an optimal signal-to-
noise ratio.

Note: If the gel has already been activated for 2.5 min, activating 
it for another 2.5 min may improve it; but activating an image for 
more than 5 min will not.

Imaging Blots
To blot stain-free gels, use standard blotting procedures as described in the 
instruction manual you are using. Use only PDVF membranes with low 
background fluorescence, as membranes other than low fluorescence PDVF 
can result in high background or low sensitivity with the ChemiDoc MP 
imager.
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To assess transfer efficiency, be sure to activate and visualize the gel using 
the ChemiDoc MP imager before transfer.
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B Troubleshooting
Follow these suggestions to troubleshoot your ChemiDoc™ MP system.

Problem Possible Cause Solution

ChemiDoc MP System

Camera does not 
respond/camera not 
found

• Camera power may be 
turned off.

• Camera cables may not be 
seated properly.

• Software driver for the 
camera is missing.

• Computer power-saving 
modes may be interfering 
with the camera driver.

• Cables may be defective.
• Camera may be defective.

• Turn on the power to the camera.

• Make sure that all cables are connected 
as shown in the Installation Guide.

• If camera driver is not present, reload 
the camera driver from the 
Image Lab™ software CD.

• Disable power-saving modes on the 
computer.

• Replace cables.
• Replace camera.

Horizontal stripes in 
image when using the 
UV mode

• Emission filter not in proper 
position

• Move filter lever so that the filter slider 
positions the filter under the camera 
lens.

Image is not visible on 
the monitor

• Incorrect monitor settings
• Lens cap attached

• See your computer manual for settings.
• Remove lens cap.

Image is not bright 
enough

• Wrong emission filter in use.
• For chemiluminescence, 

emission filter is in front of 
lens.

• Verify correct filter for application.
• Verify no emission filter is in front of 

lens.
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Printout does not look 
like the monitor image

• Monitor settings are wrong

• Printer settings are wrong

• Refer to monitor instructions to correct 
settings.

• Refer to the printer manual to correct 
settings.

Light leakage into the 
darkroom

• The lens body is not seated 
properly against the gasket 
on the hood’s adapter plate.

• Loosen the thumbscrew and seat the 
lens properly against the gasket on the 
hood’s adapter plate.

Unable to focus on the 
sample using white 
light transilluminator or 
conversion screen

• Focus is not calibrated for 
samples using this light 
source.

• Select Edit > Instrument Setup to 
recalibrate focus using the proper 
accessory.

Lens limits seem 
artificially restricted

• Camera lens not seated 
properly on lens mounting 
plate

• Reseat camera on lens mounting plate.

Problem Possible Cause Solution
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C Accessories

Calibrating Accessories
If you are installing accessories along with your original system installation, 
calibrate your system with a one-time Instrument Calibration wizard. 
Complete instructions are in the installation guide that arrives with your 
system. If you acquire new conversion screens, light sources, or filters for a 
ChemiDoc™ MP imaging system after your original system installation, you 
will have to recalibrate your system to use them. 

See Chapter 2, System Calibration, for instructions on how to calibrate newly 
acquired accessories.

Installing Optional Accessories

Epi Light Modules
Epi light modules are available for the ChemiDoc MP system in three colors: 
red (catalog #170-8283), blue (catalog #170-8285), and green (catalog #170-
8284). For installation instructions, see Installing an Epi Light, an instruction 
sheet that accompanies each module.
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UV/White Light Conversion Screen
This optional white light conversion screen (catalog #170-8001) converts the 
UV light generated in the universal hood to white light. Your system must be 
calibrated to use the white light conversion screen.

To calibrate, go to the Edit > Instrument Setup dialog box and select the 
appropriate checkbox. The Image Lab™ software guides you through the 
calibration.

To use the white light conversion screen
1. Center the conversion screen on the imager stage.

2. Center your samples on top of the conversion screen.

3. Image the gel using your preferred application.
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XcitaBlue™ Conversion Screen
The optional XcitaBlue conversion screen kit (catalog #170-8182) converts UV 
to blue light, which enables you to visualize DNA samples while protecting 
them against UV damage.

The XcitaBlue conversion screen is held in place by adhesive-backed edge 
guides. After the edge guides are installed, the conversion screen remains 
centered and will not slide, even if you close the drawer rapidly.

To install the XcitaBlue conversion screen
1. Perform a trial placement first, without removing the paper tape. Place 

the edge guides in each corner of your transilluminator, as shown. The 

Adhesive-backed
edge guide

Transilluminator
drawer front

Transilluminator
border edge
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edge guides should touch the inside of the drawer front and fit over the 
edge of the metal transilluminator border (shown in red).

2. Calibrate your system to use this accessory by going to Edit > 
Instrument Setup. Select the XcitaBlue Conversion Screen checkbox 
under Illumination Options. The software prompts you to calibrate the 
focus with height offset.

3. To visualize a sample using the XcitaBlue conversion screen, place the 
screen between the edge guides.

4. Center the gel on top of the XcitaBlue conversion screen, and proceed 
with normal image capture. Use the gel alignment template kit to center 
your gels easily and consistently. 

Gel Alignment Template Kit
The Bio-Rad gel alignment template kit (catalog #170-8184) allows four sizes 
of standard agarose gels to be centered quickly and easily and ensures the 
consistent placement of each gel. 

The kit contains:
• Magnetic locator frame
• Instruction sheet
• Alignment guides for the following gel trays:

Sub-Cell® GT UV-transparent mini-gel tray, 7 x 7 cm

Sub-Cell GT UV-transparent wide mini-gel tray, 15 x 7 cm

7 x 7 cm 15 x 7 cm 7 x 10 cm

Magnetic
locator
frame

15 x 10 cm
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Sub-Cell GT UV-transparent mini-gel tray, 7 x 10 cm 

Sub-Cell GT UV-transparent gel tray, 15 x 10 cm

The gel alignment templates fit exactly into the XcitaBlue conversion screen 
frame (catalog #170-8183).

To install and use the gel alignment template kit
1. Place the locator frame over the transilluminator with the magnetic side 

down. Match the corners of the magnetic locator frame with the edges 
of the transilluminator. The UV symbol on the frame will be in the same 
orientation as the UV symbol on the imager.

2. Place the gel alignment template that matches the size of your sample 
tray or agarose gel into the magnetic locator frame.

3. Place your gel or gel tray into the open area of the template.

Note: No recalibration is necessary to use the gel alignment 
template kit.

Orange Fluorescence Reference Plate
The orange fluorescence reference plate allows you to apply UV flat fielding 
corrections to your ChemiDoc MP imager. Corrections are made for all UV 
illumination sources, filters, and the camera lens. 

The orange fluorescence reference plate can be used to correct for image 
nonuniformities for red and orange gels, including:

• Ethidium bromide
• GelRed
• Flamingo™ fluorescent gel stain
• Coomassie Fluor Orange
• SYPRO Ruby protein blot stain
• Krypton
• Qdot 625
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The orange fluorescence reference plate (catalog #170-8008) can be used 

with several of the Bio-Rad® Molecular Imager® series of products, including:
• ChemiDoc MP system with Image Lab software
• ChemiDoc XRS+ system with Image Lab software

• ChemiDoc XRS+ system with Quantity One® software

When you order the reference plate, you receive:
• Orange fluorescence reference plate, overall dimensions: 29.5 x 

29.5 cm; viewing surface: 27 x 27 cm
• Instruction sheet (10017296)

CALIBRATING THE SYSTEM TO USE THE ORANGE 
FLUORESCENCE REFERENCE PLATE 
Your system must be calibrated to use the orange fluorescence reference 
plate.

To calibrate, go to the Edit > Instrument Setup dialog box and select the 
appropriate checkbox. Image Lab software guides you through the 
calibration.
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Ordering Information
The following table contains catalog numbers and descriptions for all parts 
available for the ChemiDoc MP system, plus all optional accessories and 
replacement parts. For more information, see the Bio-Rad catalog.

Catalog # Description

Molecular Imager Series of Products (includes Universal Hood III, Camera, Cables, and 
Accessories)

170-8280 ChemiDoc MP system

Installation Kits

170-8282 ChemiDoc MP installation kit

Universal Hood

170-8281 Universal Hood III

Imaging Cameras

170-8255 ChemiDoc MP camera with motorized zoom lens

Image Lab Software

170-9690 Image Lab software, Windows/Mac

Optional Accessories

170-8001 UV/White light conversion screen (UV to white light)

170-8182 XcitaBlue (UV to blue light) conversion screen kit, without standard detection filter

170-8283 Kit, Red LED Module

170-8284 Kit, Green LED Module

170-8285 Kit, Blue LED Module

170-8183 XcitaBlue (UV to blue light) conversion screen kit, with standard detection filter

170-8008 Orange fluorescent reference plate 

170-8089 Mitsubishi P93W Printer, 100/240 V, USB

170-3759 Bio-Rad fluorescent ruler

170-3760 Gel cutter ruler

170-8184 Gel alignment template kit 

Replacement Parts

170-8026 Image Lab focus calibration target

170-8027 Image Lab flat fielding disc

170-8185 XcitaBlue viewing goggles

170-7581 Mitsubishi thermal printer paper, 4 rolls
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170-7813 Sample holders for gels

100-2784 UV transilluminator lid (includes UV filter glass)

1001-4106 Thumbscrew for camera

170-8081 Filter, standard emission, 62 mm

100-1370 UV bulb starter, quantity 3

930-2242 Multicolor target

Lamps

100-1361 UVB lamp, 302 nm (1 each)

170-8097 302 nm lamp kit, (6 lamps)

170-8098 254 nm lamp kit, (6 lamps)

170-6887 365 nm lamp kit, (6 lamps)

Fuses

900-8935 Fuse T 2 A, 250 V, quantity 10

900-0234 Fuse T 4 A, 250 V, quantity 10

Universal Hood III

100-2787 Universal Hood feet, quantity 4

170-8068 UV Shield for Universal Hood

Connection Cables

931-0071 Cable, USB, Type A to B, 10 ft

901-0064 Cable, USB, Type A to B, 6 ft

Optional Analysis Software

170-9600 Quantity One 1-D Analysis software

170-9300 FPQuest™ software

170-9310 InfoQuest™FP Basic Fingerprint software

Protein Standards

161-0363 Precision Plus Protein™ Unstained Standards. 1 ml

161-0373 Precision Plus Protein™ All Blue Standards, 500 pl

161-0374 Precision Plus Protein™ Dual Color Standards, 500 pl

161-0375 Precision Plus Protein™ Kaleidoscope™ Standards, 500 pl

161-0385 Precision Plus Protein™ WesternC™ pack, 50 applications

161-0318 Prestained SDS-PAGE standards, broad range, 500 pl

161-0317 Unstained SDS-PAGE standards, broad range, 200 pl

Catalog # Description
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Nucleic Acid Standards 

170-8351 EZ Load™ 20 base pairs molecular ruler

170-8352 EZ Load 100 base pairs molecular ruler

170-8353 EZ Load 100 base pairs PCR molecular ruler

170-8354 EZ Load 500 base pairs molecular ruler

170-8355 EZ Load 1 kb molecular ruler

170-8205 2.5 kb molecular ruler

170-8200 AmpliSize® molecular ruler

170-8356 EZ Load precision molecular mass ruler (base pairs/ng of sample)

Pulsed Field Standards and Markers

170-3624 CHEF DNA size standard, 5 kb ladder

170-3707 CHEF DNA size standard, 8-48 kb

170-3635 CHEF DNA size standard, lambda ladder

170-3605 CHEF DNA size marker, 0.2-2.2 Mb

170-3667 CHEF DNA size marker, 1-3.1 Mb

170-3633 CHEF DNA size marker, 3.5-5.7 Mb

Catalog # Description
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D Mitsubishi P93/P95
Thermal Printer

Setting up a Thermal Printer on Windows
The printer driver can be found on the Image Lab™ software installation CD in 
the Misc directory. 

To set up a thermal printer on a Windows system

1. Install the printer driver. 

2. Open the printer section in Control Panel.

3. Click the thermal printer icon and select Printing Preferences.
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4. Configure the correct paper size: select 1280 x 1280.

5. Click OK to apply your changes.

Setting up a Thermal Printer on a Mac
The printer driver can be found on the Image Lab software installation CD in 
the Misc directory. 

To set up a thermal printer on a Mac system

1. Install the printer driver.

2. Connect the printer to the computer.

To configure the correct paper size

1. Start Image Lab software.

2. Select File > Page Setup.
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3. In the Settings dropdown list, select Page Attributes.

4. In the Format For dropdown list, select the Mitsubishi printer.

5. In the Paper Size dropdown list, select 1280 x 1280.

6. In the Settings dropdown list, select Save as Default. 

7. Click OK to save the settings.
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E Regression Calculation 
Methods

Each regression method calculates a standard curve. Some of the methods 
provide the formula for the standard curve. In this case, the molecular weight 
can be calculated by:

x = relative front of the band of interest

y = molecular weight of the band of interest

Linear (semilog): The linear equation is y = a + bx, where a is the intercept 
and b is the slope of the line. 

Note: The linear equation is calculated on the log of the 
molecular weight values.

The R2 value may be used to determine the overall quality of the linear fit. A 

linear regression with an R2 value of >0.99 is considered a very good fit. The 
primary advantage of this method is that it is extremely simple. The primary 
disadvantage is that it will deliver incorrect results if the data are not very 
linear.

Point-to-point (semilog): No single equation is available for the point-to-
point method. The slope of each segment of the curve between data points is 
calculated independently.

Note: The log of the molecular weight values is used to calculate 
the slope for each segment of the curve.
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Logistic: The logistic-4PL equation is

where:

x = mobility

y = molecular weight

a = estimated molecular weight at infinity

b = slope of the tangent at midpoint

c = midpoint

d = estimated molecular weight at zero mobility

Since the curve generated by the logistic-4PL regression method represents a 
perfectly shaped S, it might not fit the data very well in all cases.

Cubic spline: Cubic spline curves are smooth curves that go through every 
data point. The model is a cubic polynomial on each interval between data 
points. In some cases, a spline curve can work well as a standard curve for 
interpolation. However, because the curve is calculated individually for every 
pair of points, it does not correspond to any single equation.
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Glossary

Aspect ratio: The ratio of the width to the height of an image.

CCD: (Charge-coupled device) A light-sensitive silicon chip used as a 
photodetector in ChemiDoc™ MP and ChemiDoc™ XRS+ camera systems. 

Colormaps: Different color representations of a gel image.

Electrophoresis: A technique for separating molecules based on the 
differential movement of charged particles through a matrix when subjected to 
an electric field.

Example precision: The number of decimal places chosen for 
displaying a measurement.

Flat fielding: An average intensity computation that compensates for 
nonuniformities generated by an instrument.

Histogram: A graphed representation of the brightness, or gray value, of 
an image. 

Native charge density: The inherent electrical charge of a protein 
without the addition of SDS.

pl: Isoelectric point; the pH at which a protein molecule carries no net 
charge.
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Rf: Relative front value of the band. In Image Lab™ software, Rf has a value 
between 0 and 1, and indicates the relative movement of the band from top to 
bottom.

Quantitative imaging: Determines the quantity of a protein’s 
components through analysis of the pixel values in a digital image of the 
sample.

UV-B: The range of ultraviolet light used by the system.

UV transilluminator: The part of the imager that transmits UV light 
through a sample.
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